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PREFACE

Welcome to the Oracle Insurance Insbridge Rating and Underwriting Installation and Upgrade Guide.
The Insbridge Rating and Underwriting (IBRU) System is a browser-based, multiplatform
insurance rating and underwriting technology solution that provides integrated management for
every aspect of the rate definition and modification process. This guide will help with the
installation of the Insbridge Rating and Underwriting System.

AUDIENCE

This guide is intended for system administrators, installers, database administrators and others
tasked with installing and configuring the IBRU system and associated databases.

TYPES OF INSTALLATION

There are various types of installations:

Windows Only Installation

o Full RateManager Installation — This installation will install RateManager and the
Insbridge Framework Administrator (IBFA). This is for a Windows only environment,
using a SQL Server database.

o SoftRater Node Installation — This installation is for existing environments that want to
add a Windows SoftRater node to an environment.

o Database — Incorporating an Oracle Database in a Windows Environment.

Incorporating a Java Environment

o Full SoftRater Installation on a Java Machine — This installation will install SoftRater
on a Java machine, using a SQL Server database.

o Full SoftRater Installation on a Java Machine — This installation will install SoftRater
on a Java machine, using an Oracle database.

Upgrading

o Upgrade - If you attempting to update from a 32-bit Insbridge instance to a 64-bit
Insbridge instance, please contact Oracle Support.

This guide will describe a Windows Only installation, and Incorporating an Oracle
Database.
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E-Delivery

The Insbridge Rating and Underwriting (IBRU) System is available as a download from the Oracle
E-Delivery system. Downloaded files are zipped. Prior to installation, please make sure the
source machine(s) where IBRU will be loaded has an unzip utility. An unzip utility for most
platforms is available on the E-Delivery download page.

Documentation from E-Delivery is in PDF format. Prior to installation, please make sure the
source machine(s) where IBRU documentation will be loaded has a PDF reader.

Files are downloaded with part numbers as file names. Please make note of the part numbers
you have downloaded and the corresponding file name. You may be asked to provide the part
numbers or the filename if you contact Oracle Insurance Support.

The installation downloads you can select are:

Insbridge IBRU Install — This is required for all installations

SoftRater for WebSphere — This is required if you are using WebSphere

SoftRater for WebLogic — This is required if you are using WebLogic

SoftRater for JBoss — This is required if you are using JBoss

Documentation — It is recommended that you download the documentation. Installation
guides and user guides are located here.

The Insbridge IBRU install is required for all installations.
The 4.0.1-Insbridge-IBRU folder contents:

- Databases
Oracle
- SoftRater — IBSR
o0 Usp_ IBSR v03.12.0.oracle
SQL Server
- RateManager — IBRM
0 Latin1_General_BIN
= DATABASE_BACKUP_IBRM_TEMPLATE_CASE_SENSITIVE.bak
o SQL_Latin1_General_CP1_CI_AS
= DATABASE_BACKUP_IBRM_TEMPLATE.bak
- Security — IB_CLIENT
o SQL_Latin1_General_CP1_CI_AS
= DATABASE_BACKUP_IB_CLIENT_TEMPLATE.bak
- SoftRater — IBSR
o0 Latin1_General_BIN
» DATABASE_BACKUP_IBSR_TEMPLATE_CASE_SENSITIVE.bak
o SQL_Latin1_General_CP1_CI_AS
» DATABASE_BACKUP_IBSR_TEMPLATE.bak
o Usp_ IBSR v03.13.0.sql
- IE7 Users
Insbridge IE Active X Control Update PDF
RateManager_|E7.exe
- Oracle Bl Publisher
OBI_PUBLISHER.exe
- Oracle Client
setup.exe (the other files in the folder are needed for setup to run)
- Oracle Insurance - Insbridge Rating and Underwriting (x64).exe
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You will be required to run the installation file and create the IB_CLIENT database for any new
installation. The other folders and files may not be needed, depending upon the kind of setup you
want. Everything for a Windows only installation is in the 4.0.1-Insbridge-IBRU folder. If you want
to incorporate a Java environment, please download the corresponding SoftRater file. SoftRater
downloads are not required if you are running in Windows only.

Definitions

Some commonly used terms when installing or using the Oracle Insurance Insbridge Rating and
Underwriting system:

IBRU — Insbridge Rating and Underwriting System. This is the entire system.

IBFA — Insbridge Framework Administrator. IBFA is an administrative tool used to
configure Insbridge applications and setup RateManager database connections. IBFA will
be located on a Windows Server machine. IBFA/SR-WIN is an Insbridge Framework
Administrator/SoftRater for Windows.

IBSS - Insbridge SoftRater Server. IBSS is the administrative tool for the SoftRater
engine. The SoftRater engine is a multi-platform component within IBRU that executes
the rules, rating and underwriting instructions as defined by the user in RateManager.
IBSS is usually located on a Java machine. IBSS/SR-JAVA is an Insbridge SoftRater
Server/SoftRater for Java.

SoftRater Node — A SoftRater node is either an IBFA (without RateManager) or IBSS
instance on a physical environment.

RM — RateManager. RateManager is a component within IBRU that enables users to
manage the product definition and modification process, including rating and underwriting
logic.

SR — SoftRater. The engine that executes the rating, rules and underwriting instructions
defined within RateManager. The rating environment for runtime execution and
processing of business content. SoftRater can be further defined by the operating system
where it has been loaded.

SR-WIN — SoftRater for Windows. This is also another name for IBFA.

SR-JAVA - SoftRater for Java. This is also another name for IBSS.

SRP — SoftRater Packages. A package that holds all the RateManager logic for a specific
program and version.

VFS — Virtual File Servers. Virtual file server management allows you to access
environments that are located on other machines in different locations where packages
can be downloaded.

Package Location — A pointer to a location where SoftRater Packages (SRP’s) are
stored.

Physical Environment — A physical environment is generally referred to as a physical
machine.
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e Authoring Environment — The physical machine where RateManager is installed.

o Rating Environment — The physical machine(s) where SoftRater is installed. This is
typically the same as a SoftRater node.

o Logical Environment — An environment created for a subscriber in IBFA. It defines
package location, engine location and database location in addition to several other

supporting data items. This environment is used for rating and/or SRP management.
Each database connection will have a logical environment.

Manual History

New editions incorporate any updates issued since the previous edition.

Publication Product

Edition Number Version

Publication Date Comment

1% Edition P01-702-01 R4.01 08/31/2010 Updated for 64-bit /
Windows 2008
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Chapter 1
PLANNING YOUR IBRU SYSTEM

Prior to installation, you should have an idea of the type of setup you want to create. What kind of
equipment do you have available and how many environments do you need? If you do not have
everything completely planned out, you can still proceed. Environments can be removed or added later
on. The Oracle Insurance Insbridge Rating and Underwriting system (IBRU) is expandable and can
accommodate a few different configurations.

Databases

RateManager and IBFA require a SQL Server database. RateManager and IBFA can utilize either SQL
Server 2005 SP/2 or 2008 SP/1. SoftRater can use a SQL Server 2005 SP/2 or 2008 SP/1 database, an
Oracle 10g or 11g database or an IBM DB2 v9.1 database or a combination of databases. SQL Server
can be the only database system used. No other database system is required; however another database
system can be used if you want.

For the examples in this guide, physical environments that use SQL Server will have one database per
environment. For Oracle or DB2, QA and Production will share a database.

For use in this installation guide, SQL Server will refer to either SQL Server 2005 SP/2 or 2008 SP/1.
Differences between SQL Server 2005 SP/2 and 2008 SP/1 will be pointed out where they occur.

NOTE: While it is possible to have RateManager, IBFA and SQL Server all on the same machine, it is not
recommended due to performance and security issues. This option will not be discussed in this
document.

Physical Environments

A physical environment generally refers to a physical machine where a specific activity is performed. For
example, a physical environment called development could be created where users only create rating
programs. Another physical environment called QA could be where users only test ratings. There is no
limit to the number of physical environments you can have.

It is recommended that three physical environments be setup; one for development, one for testing or
quality assurance (QA) and one for production.

o Development — this environment holds RM and an IBFA instance on the same Windows Server
machine and will utilize a SQL Server database. This environment is most often used for the
creation of rating and underwriting logic. Once development is complete, SRPs will be copied into
a QA environment.

¢ QA —this environment can contain either an IBFA instance or an IBSS instance, depending upon
the database and machine to be used. If a Windows machine is used, an IBFA instance will be
installed. If a Java machine is used, an IBSS instance will be installed. This environment is most
often used for the testing of SRPs prior to being placed into Production. Once testing is complete,
SRPs will be copied to production.
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e Production — this environment can contain either an IBFA instance or an IBSS instance,
depending upon the database and machine to be used. If a Windows machine is used, an IBFA
instance will be installed. If a Java machine is used, an IBSS instance will be installed. This
environment is most often used for rating.

Authoring Environment

The authoring environment is the physical machine where RateManager is installed. This machine must
be a Windows Server machine and must utilize a SQL Server database.

Although it is possible to have more than one authoring environment, it is recommended that only one
authoring environment be setup in development.

Rating Environments

The rating environment is comprised of the physical machines where SoftRater is installed. You can have
multiple machines in a rating environment.

One rating environment should be setup encompassing testing or quality assurance (QA) and production.
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IBRU Environments
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Logical Environments

A logical environment is an environment created for a subscriber in IBFA or IBSS. This environment is
used for rating and/or SoftRater package (SRP) management. The logical environment defines package
location, engine location and database location in addition to several other supporting data items.

When you create logical environments, you enter the package storage locations. These are the system
folders where SoftRater packages (SRP) are stored. When an SRP is created, the file is stored in the
folder location configured in the environment that the package was created for.

When a program is ready to go from development to the QA environment, the SRP will be placed in the
folder location that was designated for the logical environment selected. An SRP can be copied from one
logical environment to another from the SRP listing screen in IBFA. SRP’s can also be copied from a
different physical machine (that has IBFA installed) by creating a Virtual File Server.

In a Java environment, the rating environment IBFA will handle the copying and loading. No Virtual File
Server will be created. IBFA does the package management and migration. This can only be performed
by IBFA. Java environments are for rating only.

You can create as many logical environments as you want to manage.

It is recommended that at least two logical environments be configured in IBFA, one for RateManager and

one to represent the QA environment and folder location of the SRPs. It is recommended that at least one
logical environment be setup in testing or quality assurance (QA) and one for production.
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A Windows Only Environment Example:

IBRU Installation/Setup — Windows/SQL Server

( Environments — Physical and Logical

SQL Server

Must be the same
in all enviranments

ADD
DB Connections:

Controller
Security
RM

CREATE:

Logical
Environments:

RM - to handle
testing/rating.

QA_SR - This
environment
contains the full
packages (o ba
consumed by QA

~

PURPOSE of this Physical
Environment

This erwvironment is for the
creation of rating programs.

This environment also holds the
sacurity Information,

IB_CLIENT
security
Restore
o SGL
Sarver

RM
This
|IERM DB

holds Rating &
Rules

Development QA Production
Raﬂﬁtz;fi:;u'es Test Rating Production Rating
INSTALL: INSTALL: INSTALL:
IBR;A IBFA IBFA
OB Publisher 0Bl Publisher OBl Publisher
CREATE CREATE CREATE
SUBSCRIBER SUBSCRIBER SUBSCRIBER

Must be the same
in all emvironments

CREATE:

Logical
Environments:
SR — o identify the
location of the

lecal SRPs and
the QA IBSR DB.

"

CREATE:
VFS:

Taothe QA_SR
environment on
the Developgment
machine

PURPOSE of this Physical
Environment

This environment is for the testing
of packages (SRPs).

SR
Restore This IBSR OB
o S0L halds SREPs for
Sarvar thes tast

environment

Must be the same
In all ermvironments

CREATE:

Logical

Enviranmenis:

SR - to identify the
location of the
local SRPs and
the Preduction
IBSR DB.

~

CREATE:

WFs:

To the SR
environment on
the QA machine

PURPOSE of this Physical
Environment

This environment is for (real-time)
production rating. When users
send rate requests through the
system, this is the emvronment

that will do the rating.

Production_SR
Restore This IBSR DB
to S0L holds SRPs for
Sarvar the production

anvironment
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This example has three physical environments each with its own application machine and database
machine. It is possible to put all SQL Server databases on one database machine or divide over two
machines. If you select to use one or two SQL Server database machines, clear and precise naming of
the associated databases is recommended.

RateManager and IBFA must run on a Windows Server machine. No other operating system will be
required. RateManager will be installed on the Development machine only.

NOTE: While it is possible to have RateManager, IBFA and the database server all on the same
machine, it is not recommended due to performance and security issues. This option will not be
discussed in this document.

The setup for this example is:
1. All three instances of IBFA will need to be configured the same.

2. In the Development environment:
a. RateManager and IBFA/SR-WIN would be located on the same Windows machine.
b. On the IBFA/SR-WIN for this environment, three database connections would be created
and two logical environments would be created.
c. Two databases would be restored to a separate SQL Server machine.

An example of this environment setup/installation is on page 22.

3. Inthe QA environment:
a. IBFA/SR-WIN would be located on a Windows machine.
b. On the IBFA/SR-WIN for this environment, one logical environment and one virtual file
server would be created.
c. One database would be restored to a separate SQL Server machine.

An example of this environment setup/installation is on page 53.

4. Inthe Production environment:
a. IBFA/SR-WIN would be located on a Windows machine.
b. On the IBFA/SR-WIN for this environment, one logical environment and one virtual file
server would be created.
c. One database would be restored to a separate SQL Server machine.

An example of this environment setup/installation is on page 53.

You can add another environment if necessary. For example, if you wanted to create a training
environment or a second level of testing, you could add these environments in where you wanted.

There are other combinations of application servers and databases that you can use. Please contact your
Insbridge representative for more information on the configuration that you would like to have.

NOTE: For the examples in this guide, the QA and Production environments will be exactly alike to allow
for true QA standards.
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Chapter 2
SYSTEM REQUIREMENTS

Server Requirements

A full installation of Microsoft Windows Server 2008 for 64-bit is required for this IBFA/SR-WIN and
RateManager installation. IBRU installers should be familiar with managing a Windows server.

Required Components

The following components are required:

e Microsoft .NET Framework version 3.5

e |IS—Internet Information Services version 6.0 or 7.0

e For Windows 2008 Server — WCF http activation needs to be enabled
¢ MSMQ — Microsoft Message Queuing Services — basic functionality only.

e JRE - Java Runtime Environment (not required for a SoftRater Node only install)

Extended Permission Required by the Insbridge User

In order to start the Insbridge services from IBFA, the Insbridge user must be given full access to both the
Insbridge Message Service and the Insbridge Task Manager Service. If the Insbridge user account will
not have full administrative permissions on the server where the Insbridge Framework is installed, then
certain operations from IBFA will not be available. A system administrator may be required to start the
Insbridge services from the server.

Microsoft SQL Server

Microsoft SQL Server should not be installed on the same machine where the Insbridge web applications
reside. The SQL Server should reside on a separate host from the IBRU web front end with a properly
configured network connection from the web server front end to SQL Server. Testing can be performed
by using the Data Sources application in Administrative Tools to make a default connection to the
database server.

NOTE: All these settings are available during installation of SQL Server or by using SQL Server
Enterprise Manager, and right clicking the server and selecting properties.

If any of these settings conflict with existing application’s databases residing on the SQL Server,
then a separate instance is required.
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Depending on the load expected, the databases can be placed on a separate SQL Server machines that
can either be independent or shared as long as the following conditions are met.

e Server Authentication: Should be set to SQL Server and Windows Authentication mode.

o Collation and Sort Order: Currently supported is the default SQL Server collation using
SQL_Latin1_General_CP1_CI_AS and sort order plus case sensitivity using Latin1_General_BIN
as the server collation. The security database (IB_CLIENT) supports the default SQL Server
collation using SQL_Latin1_General_CP1_CIl_AS. The RateManager and SoftRater databases
can use either case sensitive or non-case sensitive. Please check with Oracle Insurance for any
questions regarding database server sort orders or collations.

NOTE: For SQL Server, please make sure the SQL Server Client is installed.

Special Considerations for SQL Server in a Java Setup

For Java setups only when connecting to SQL Server from IBSS:
e For New Installations: No action is required.
e For Upgrades: If you want to keep the current Environment settings that are in IBSS, there are
additional steps that need to be performed. Please see the SQL Server Upgrade chapter in the

corresponding SoftRater Installation Guide for the exact steps.

If you are running a Windows only environment, no additional steps will be required. This is only for
SoftRater for WebLogic, SoftRater for WebSphere and SoftRater for JBoss.

Default SQL Server Database User Roles and Permissions Required

If a more granular approach is required for management of security of the IBRU databases, then the
following guidelines can be used to set the required permissions.

NOTE: These are only guidelines. If not properly configured, certain processes within the Insbridge
Rating and Underwriting System will fail. An experienced database administrator’'s expertise is
highly recommended before making any security changes.

o IBSR Database User — Account requires database owner (DBO) access to the IBSR databases
because new tables will be created in the SoftRater (IBSR) database dynamically when or if a
new line of business SRP (SoftRater Package) is loaded to the SoftRater system.

o IBRM_xxxx and IB_CLIENT Database User — Account requires execute access against the
Insbridge stored procedures and full access to the Insbridge schema.
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INSBRIDGE LOCAL USER ACCOUNT SETUP

Before starting the installation, create a local user account where the Insbridge Framework is being
installed. This user needs to be a member of the User group and requires certain privileges in order to
fully control the entire IBRU environment. For ease of installation and if the server is dedicated to the

Insbridge Rating and Underwriting System, it is suggested that this user be added to the local machine

Administrators group.

If the installer has permissions, an Insbridge user can be created during the installation.

To create a new user:

Select Users.

HpPOON -~

E. server Manager

Select Start->Administrative Tools->Server Manager.
Select Configuration—>Local Users and Groups.

Right click and select New User.

[=]FS

Actions

File Action Wiew Help
il A e8] o NS
i Server Manager (WINSRPOO1) Users £ Ll
5 Roles
[ Marne Full Mame Diescription
Features Fw
Diagnostics B admin Account For IGBL IT Access Do not change
= 33»& Configuration ;; Administrator Built-in account For administering the. ..
— ms —~ —Ess bo k.,
Ta.sk Schec!u\er ) i New User HE
‘Windaws Firewall with Advz
o i a
""‘).5 Services 3 Username ||
G5 WML Control 2
= % Local Users and Groups Fulll e I
| Users
| Groups Description: I
25 Storage
Pazsword: I
Confirm password: I
W User must change password at next logon
™ User cannot change password
™| Pagsword rever eqpires
[ Accourt s disabled
K — i

Users
More Ackions
Insbridge

More Actions

Figure 1 Creating New User

5. Add an Insbridge User. The Insbridge User should be assigned to the local Users group and have
the same permissions as the internet guest account.
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Ideally, the Insbridge user should be added to the local Administrators group. If the Insbridge user
cannot be a part of the local administrators groups, please make sure that the Insbridge user has
permissions on the Insbridge Messaging Service and the Insbridge Task Manager Service.

Insbridge Properties H I

Remate cantral | Terminal Services Profile I Dial-in I
G ereral I tember OFf I Prafile I E nwviranment | Seszionz

L |nzbridge
i

Full name: Ilnsbridge

Description; Insbridge Uzer

™| Usen must change pazsword at nest logon
¥ User cannot change pazsword

[ Pazzword never expires

[T Accourt iz dizabled

[T Aceount is locked out

] I Cancel Apply Help

Figure 2 Adding User information

6. Click OK. Please keep this information close at hand. You will need it for the first installation.

Insbridge User Password

The password can be set to any password that meets your company standards. The IBRU administrator
must make note of the password for future configuration. For ease of maintenance, the IBRU user should
not have to change the password and the password should never expire.

NOTE: Please note that if your company requires passwords to be re-set, you will have to make changes
to the COM+ Application libraries after you change your password. The installation will
automatically apply the Insbridge user name and password to the necessary libraries. If you
change the password, you will have to change the password in all three of the Insbridge Com+
libraries. On each library, right click, select Properties, select the Identity tab, and enter in the new

password.
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Chapter 3

FULL RATEMANAGER INSTALLATION

This installation will install RateManager and the Insbridge Framework Administrator (IBFA). This is for a

Windows only environment, using a SQL Server database.

Before installing, please verify that the system requirements
are in place. Development
Rating anq Rules
The installation should be performed in the following order: futhering
1. Install the IBRU application. INSTALL:
2. Registry Access. N
QBI Publisher
a. Assigning Insbridge Access. —
b. Exporting Key for safe keeping. ESCRIBER
in all environments
3. Assigning permissions to the Insbridge User for the
Windows Temp Folder. This is necessary for MSMQ ADD
DB C tions:
4. Assigning permissions to the Insbridge User for the et
Insbridge Folder Cs?:ct[.ﬂ'r‘:'
RM
5. Creation of the IBRU databases is next. There are two
databases that must be in place.
CREATE:
a. IB_Client .
- Logical
b |BRM Environments:
RM — to handle
6. Return to IBFA and Configure: 5 tesling'rating.
a. Create your subscriber. E" Convirorment.
contains the full
b. Add database connections. % JPackages gﬂ; be
c. Create your logical environments. E -
w
Verifying Component Services. 5
Allowing for WCF Activation. _é P
c
Install OBI Publisher. 2 This enviranment is for the
= creation of rating programs
10. Login to RateManager and perform IBRU database |2 This envirenment alsa holds the
updates. u:é_l sacurty Information,
g SEEECELELEC LT LRLEE e L e
For a Windows 2008 Server installation, you must run as 5 CLIENT
Administrator. security
@
el bear
w Sarver =
— q
g IBQ‘I'SDB
holds Rafing &
Rules.
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STEP 1 — INSTALL INSBRIDGE RATING AND UNDERWRITING

1. Begin with the Oracle Insurance - Insbridge Rating and Underwriting Install file. For a 64-bit
installation, please make sure you have:

Oracle Insurance - Insbridge Rating and Underwriting (x64).exe

NOTE: The installation program requires that the installer have administrator rights on the machine
where the install is occurring. You may receive a message that an unidentified program wants
access to your computer. Please Allow.

NOTE: Please close all open applications before running the Oracle Insurance — Insbridge Rating and
Underwriting file.

2. Open the Oracle Insurance — Insbridge Rating and Underwriting file. A Welcome screen will be
displayed.

i'\.‘!:“ Oracle Insurance - Insbridge Rating and Underwriting 4.0.1 Setup M= E3 |

4 Oracle Insurance Insbridge Rating and Underwriting

It iz strongly recommended that you exit all \wWindows programs before unning this setup program.

Click Cancel to guit the setup program, then cloze any programs you have wnning, Click Hest to
continue the inztallation.

WARMIMG: This program iz protected by copyright law and international treaties.

|Inauthaorized reproduction or diztribution of this program, or any portion of i, may result in zevere civil
and criminal penalties, and will be prosecuted to the maximum extent pogsible under lam.

ORACLE’

INSURANCE

Cancel |

< Black

Figure 3 Installing Insbridge

3. Click Next to continue.
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ji& Dracle Insurance - Insbridge Rating and Underwriting 4.0.1 Setup M= Eq |

Destination Folder ORACLE

Select a folder where the application will be installed. INSURANCE

The Wize Inztallation 'wfizard will install the files for Oracle Insurance - Inzbridge Rating
and Underwriting in the following falder.

Toinstall into a different folder, click the Browse button, and zelect anather folder.

'ou can chooge not ba inztall Oracle Insurance - Insbridge Rating and Undenwriting by
chicking Cancel to exit the ‘Wise [nstallation ‘afizard.

Dezstination Folder

C:APragram Filez\OraclehGBU nzbridgeh Browse. .. |

Wize Inztallation YWizard [R]

< Back | Hest » I Cancel

Figure 4 Entering the Destination Folder for Insbridge

Choose the location where the Insbridge installation will be located. This will be the location for all
future installations for Insbridge applications. Click Next to continue.
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ji& Dracle Insurance - Insbridge Rating and Underwriting 4.0.1 Setup M= Eq |

Logon Information DRACLE‘

The following logon information is uzed by Inshbridge. INSURANCE

Specify a uzer account ba be uzed by the application, either far running a service ar for
logging onto other serverz. Uze the Browse button to chooze wzers from pour nebwaorl.
Faor damainz, user names must be in the format of DOMAINW seM ame.

User M ame: |Insl:uriu:|ge Browsze. .. |

Pazzwiord: Ixxxxxx,mﬁ

Create Mew Lzer. . |

Wize Inztallation YWizard [R]

< Back | Hest » I Cancel

Figure 5 Logon Information

5. Enter the Insbridge user name and password for the local user account you set up earlier. The
logon information screen will be displayed. You must specify a user account to be used by the
application. Please use the Insbridge user account that you set up on page 20.

NOTE: You can Create a New user at this point, if needed. Click the Create New User button to be
placed on New User screen to setup an Insbridge user.

6. Click Next to continue.
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ji& Dracle Insurance - Insbridge Rating and Underwriting 4.0.1 Setup M= Eq |

Select Features C}RACLE‘

Pleaze select which features you would like to install. INSURANCE

Feature Description:

Oracle Insurance Inzbridae B ating and
IIndenariting iz a Web-bazed rating, riles, and
underwriting syzten,

Thiz feature will be installed an the lacal hard
drive.

Thiz feature requirez OKB on vour hard drive. 1t
has 2 af 2 subfeatures selected. The subfeat. ..

Current location:
C:%\PROGRAKM FILESYORACLENGEUNNSERIDGE®

Wize Inztallation YWizard [R]

Dizk Cost Beset < Back | Hest » I Cancel

Figure 6 Selecting Features for Installation

7. The next screen will list the applications to be installed. To expand the options and view details, click
on the downward arrow. All features are checked for installation. RateManager is the only one that
you will be allowed to not install. Click Next to continue.

Options are:

o Insbridge Rating and Underwriting:
- The default option is: Entire feature will be installed on local hard drive.
- You will not be able to opt out of this selection.

e RateManager:
- The default option is: Entire feature will be installed on local hard drive.
- You will be able to opt out of this option. Select Entire Feature will be unavailable.
RateManager will not be installed.

o IBFA:
- The default option is: Entire feature will be installed on local hard drive.
- You will not be able to opt out of this selection.

e Oracle Bl Publisher:
- The default option is: Entire feature will be installed on local hard drive.
- You will not be able to opt out of this selection.
- This option does not install the OBI Publisher. Only the templates required by the IBRU
application will be installed on local hard drive.
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i'e!:l‘ Oracle Insurance - Insbridge Rating and Underwriting 4.0.1 Setup M= B |

Ready to Install the Application ORACLE

Click Mext to beain installation. INSURANCE

Click the Back buttaon to reenter the inztallation information or click Cancel to exit
the wizard.

Wize Installation ‘fizard [R]

Cancel |

¢ Back

Figure 7 Ready to Install

8. A Ready to Install screen will be displayed. If you are ready, click Next. Otherwise click Back to check
the options you want to install.

i'e!:l‘ Oracle Insurance - Insbridge Rating and Underwriting Setup [_ 5] |
Updating System ORACLE
The features you selected are currently being installed.
Y v hend INSURANCE

Walidating inztall...

Wize Installation ‘fizard [R]

Figure 8 Installation Progress
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ji& Dracle Insurance - Insbridge Rating and Underwriting 4.0.1 Setup M= Eq |

Readme Information DRACLE‘

|nzbridge has been successfully installed. INSURANCE

Microsoft Windows 2003/2008 Server o
A full installation of Microsoft Server 20032008 is required. The following
configuration assumes that the administrator of the senver to be generally
familiar with managing a Windows server. i

Internet Information Services (lI5)

The InsBridge Rating and Underwriting System is a web based application and
requires IS to be installed before installation to facilitate the default web virtual
directaries creations.

The subcomponents of IS needed by IBRL:

. Commaon Files
. Documentation
. Internet Information Serices Snap-In |

YWize [nstallation ‘wizard®

Figure 9 Install ReadMe Screen

9. Click Finish to finish the installation. The installation should complete successfully.
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STEP 2 — CONFIGURING REGISTRY ACCESS

NOTE: If you use Registry Editor incorrectly, you may cause serious problems to the operating system.
These problems may require you to reinstall your operating system. Insbridge cannot guarantee
that you can solve problems that result from using Registry Editor incorrectly.

By default, only administrative and power user accounts have full permissions over this key. The
Insbridge user must also be given full control over the following registry key:

HKEY_LOCAL_MACHINE/SOFTWARE/Insbridge
Assigning Permissions for the Registry Access

1. Selecting Run from the Start Menu.
2. Type regedt32. Click OK. The Registry Editor will open.
3. Browse to HKEY_LOCAL_MACHINE. Select SOFTWARE->Insbridge.

& Registry Editor

File Edit Wiew Favorites Help

(=118 Computer Hame Type | Data
J HKEY_CLASSES_ROOT ab|(Default) REG_SZ {value not set)
+ . HEEY_CURREMT_UUSER
. HEEY_LOCAL_MACHIME
H- ) BCDO0000000
H- ) COMPOMENTS
H
)

| HARDWARE
- L 5AM

""" . SECURITY

=~ | SOFTWARE

< Classes

- Clients

- L Ghu

- Hewlett-Packard
Expand
Mew 3
Find...

Delete
Rename

P 0 O e O O e e O O e O e O e O e

Expork

Permissions...

Copy Key Mame

[#- [ S¥STEM
[+ | HKEY_USERS
[#- | HEEY_CURRENT_CONFIG

|ComputeriHKEY_LOCAL_MACHINE\SOFTWAREInsbridge 4

Figure 10 Configure Registry Access Windows Server
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4. Right click and select Permissions.
Click Add.

6. On the Select Users or Groups popup, you can leave the defaults for the Object Types and
Locations or enter the values you require.

o

Select Users or Groups ﬂ

Select thiz object type:

ILlsers, Groups, or Buil-in security principals Object Topes...

Erarn thig location;
|WINSF|F'EIEI1 Locations...

Enter the object namesz to zelect [examples]:
inzbridgel Check Mames

i

Advanced. .. | 0k, I Cancel |

4

Figure 11 Entering the User

7. Enterin the user name (Insbridge) and click Check Names. If the user name is found, it will be
listed. If the name is not found, an error screen will be displayed. Cancel out and to return to the
Select Users or Groups popup. Click Advanced to search. To search the directory, click Find
Now and scroll through the list until you find the user name you need. If the user name is not
listed, return to User Accounts and verify the user name was created.

8. Once the name is listed, click OK.
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9.

. Permissions for Inshridge
Security |

Group or user names:

528 CREATOR OWHER

52 SWSTEM

l Insbridge [*WIMSRPO01 4 nebridge]

52 Administrators [4/INSRPO0T\Administrators]
52 Users WINSRPOOTS zerg)

Add... | Bemove |

Pemizzions for |nsbridoe Sl Deny

Full Contral O
Read O
S pecial permizsions O O

For zpecial permizzions or advanced zettings, Advanced |
click Advanced. =

| earn about access conbol and permiszions

k. I Cancel | Apply

Figure 12 Applying Permissions for Insbridge User

On the Permissions screen, make sure the Insbridge user is highlighted and check to give Full

Control to the entire Insbridge key.

10. Click OK.

1.

Export Insbridge Registry Key for Backup

Select the Insbridge key: HKEY_LOCAL_MACHINE->SOFTWARE->Insbridge.

2. Right click and select Export.
3. Select a storage location for the file and Save.
4. Close out of Registry Editor.
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STEP 3 — ASSIGNING PERMISSIONS — TEMP FOLDER FOR MSMQ

Assigning Permissions for a Windows Temp Folder for MSMQ

1.

Open Documents. Find the WINDOWS folder, most likely on your C drive.

2. Right click the Windows—->Temp folder.

; }v | .+ Computer = Local Disk (C:) = Windows = Temp - - lml ISearch l‘_ﬂj
File Edit Wiew Tools Help
Organize v = Views - ©
Favarite Links MName = |v| Dake modified |v| Tvpe |v| Size |v| Tags |v|
| TestEngDat64 2[8f2010 12:54 PM  File Folder
[ Documents || DMIZFE tmp /312010 10:30 AM  THP File OKE
'.E Pickures || DMIFCES. kmp 2faf2010 10:30 AM TMP File OKB
"[] Plusic | Fratsgmafile0n. sqm 7/12/2010 12:58... SOMFile 1 KB
Mare 3 | Pwtsqrafiledl.sqm 7/19/2010 1116 PM SQM File 1 KB
| Fratsgmfile02,sqm 7/26/2010 1:34 PM S0M File 1 KB
Falders w L |Fetsgmfile03.sgm g/2i2010 1:47 PM - S0QM File 1 KB
Fwtsgmfile04. sgm 8/9/2010 1:53PM  S0QM File 1 KB
| Tasks ;I -—F " , ’
| Pwtsgmfileds. sqm 3/16/2010 1:54 PM S0QM File 1 KB
/ M | Pwtsqrafile0e, sqm 8/23/2010 2:02 PM SQM File 1 KB
I || Ftsgmfile?.sqm 8/30/2010 2:07 PM SQM File 1KB
Explare | Pwksqrafile0s, sqm 4/1212010 3:23 PM S0QM File 1 KB
Cpen J | Fratsgmfile0,sqm 4/19/2010 3:28 PM S0OM File 1 KB
| Pwtsgrafile 10, sqm 4/26/2010 3141 PM S0QM File 1 KB
) Share... || Prutsamfile11,5qm S/6/Z010 9:35 &M SOM File 1KE
oD [ Scan For threats. ., || Pwtsgmfile12.sqm 5/13/2010 9:50 AM  SQM File 1 KB
=] l_.'l" Mekwo ) ) | Fwksqrafile13.sqm 5/24/2010 11:12.,. SQM File 1 KB
i p3pq  [LEStOrE previous versions || Fwtsamfile14.sqm 5/31/2010 11:27... SQM File 1KB
M| aMs| Send To | Pwtsqrafile 15, sqm B/7f2010 11:42 AM S0QM File 1 KB
L o, | Fratsgmfile16.5qm 6/14/2010 11:58... SOM File 1 KB
1M s CEW __FwtsqmF!Iel?.sqm B/21f2010 12:06.,. 3S0M F!Ie 1 KB
(M A | Fratsgmfile18,5qm glzafz010 12:21,,.  SGMFile 1 KB
M gREl  Delets || Pwtsgrafile 19, sqm _ F/Si2010 12:37 PM SOM File 1 KB
M asc . | |FxsTIFFDebuglogFile  4/29/2010 9:35 AM  Text Document OKE
M ASE e
L
s I -|

Figure 13 Assigning Permissions for the Insbridge User on Windows Temp

o0k w

® N

Select Properties. The Temp Properties screen will open.

Select the Security tab.

Click Edit.

On the Permissions for Temp screen, select the Insbridge user and click Add. If the Insbridge
user is not found, cancel out and return to the Local Users and Groups area in Server Manager
and verify the Insbridge user was created.

Update the permissions. The Insbridge user requires Full Control.
Click OK to close the Permissions for Temp screen.

Click OK to close the Temp Properties screen.
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STEP 4 — ASSIGNING PERMISSIONS — INSBRIDGE FOLDER

Assigning Permissions for an Insbridge Folder Location

1. Open Documents. Locate the INSBRIDGE folder, most often the Insbridge folder is located at:
C:\Program Files\Oracle\IGBU\Insbridge.

2. Right click the INSBRIDGE folder.

'ﬁ Insbridge _ [O0]
Gl\ )v | . = Local Disk (C:) = Program Files » Oracle » IGBU ~ Insbridge - v l‘ﬂJ ISearch ¥
File Edit “iew Tools Help
Organize v =5 Wiews ¥ (7]
Eavorite Links Mame I"I Date modified IvI Type IvI Size I'I Tags I"I
L COM+ S/3002010 6:50PM  File Folder
[f) pocuments | Framewark 4/29/2010 9:54 AM  File Falder
[E pictures = 4/29(2010 9:54 AWM File Falder
F[}‘l Music . SoftRater 4/29/2010 9:54 AM  File Folder
More s | iebs 412902010 3:54 AM  File Folder
Falders v
= . Cracle ﬂ
= | IEEU
Collapse
[+]
& Explare
Jpen
Share. ..
J Pa K Scan for threats, ..
. Ref
| Wi Restore previous versions
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Figure 14 Assigning Permissions for the Insbridge User on Insbridge

3. Select Properties. The INSBRIDGE Properties screen will open.

4, Select the Security tab.

5. Click Edit.

6. On the Permissions for INSBRIDGE screen, select the Insbridge user and click Add. If the
Insbridge user is not found, cancel out and return to the Local Users and Groups area in Server
Manager and verify the Insbridge user was created.

7. Update the permissions. The Insbridge user requires Full Control.

8. Click OK to close the Permissions for INSBRIDGE screen.
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Figure 15 Setting Permission for Insbridge Folder

9. Click OK to close the Temp Properties screen
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STEP 5 — RESTORING IBRU DATABASES IN SQL SERVER

Because many corporate environments have a separation between the system administrator and the
database administrator, the following process may require both administrators’ access and permissions.
Make sure you have a SQL Server account called ibru.

NOTE: If you do not have database permissions, you will not be able to perform the following database
procedures.

NOTE: If you are unsure how to perform a database restore, please consult with your database
administrator.

Currently supported is the default SQL Server collation using SQL_Latin1_General_ CP1_CIl_AS and sort
order plus case sensitivity using Latin1_General_BIN as the server collation. The security database
(IB_CLIENT) supports the default SQL Server collation using SQL_Latin1_General_CP1_CI_AS. The
RateManager and SoftRater databases can use either case sensitive or non-case sensitive. Please check
with Oracle Insurance for any questions regarding database server sort orders or collations.

1. Located in the Insbridge Installation Directory:

SQL Server
- RateManager — IBRM
0 Latin1_General_BIN
= DATABASE_BACKUP_IBRM_TEMPLATE_CASE_SENSITIVE.bak
o SQL_Latin1_General_CP1_CI_AS
= DATABASE_BACKUP_IBRM_TEMPLATE.bak
- Security — IB_CLIENT
o SQL_Latin1_General_CP1_CI_AS
= DATABASE_BACKUP_IB_CLIENT_TEMPLATE.bak

2. Select the RateManager backup file you want to use, case sensitive or non-case sensitive. The
Security — IB_CLIENT file is only non-case sensitive.

3. Copy both files to an appropriate database folder on the machine where SQL Server is installed.
For example, [Drive]:\\Program Files\Insbridge\Databases. If you are unsure of a location, please
consult with your database administrator.

4. Rename files. It is not required but it is strongly suggested that the database file names be
changed from TEMPLATE to something that defines the databases more accurately. At a
minimum, it is recommended that you remove “ TEMPLATE” from the name. You can change the
names after they have been restored also.

5. Open the SQL Server Management Studio either on the server or remotely using either an
administrative account with sa privileges or as the sa account.

NOTE: If you do not have SQL Server Management Studio, check to see that the SQL Server Client has
been installed. For a SQL Server install, you must have the SQL Server Client installed.
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Figure 16 Restoring a Database to SQL Server

6. Go to Databases.

icrosoft SOL Server Management Studio - [Object Explorer Details]

L_‘ggi File Edit Wew Tools Window Community Help -F X
Quewoey || BBE/IE SIS E S BB,
2 - 7 X

EaT
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= [ﬂ Southern (0L Server 9.0,4035 - sa) \1
NS Databases
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[ Security SOUTHERM\Databases 131 Item(s)
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Figure 17 Right Click to Restore Database
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7. Right click on Databases.

8. Select Restore Database... A separate screen will be displayed.

I Restore Database - IB_CLIENT

Select "_;S Script - m Help

% General

=] 3

1 Oplions

Server
Server

Connection:
za

4 View connection properties

Degtination for restore

Select ar type the name of a new ar existing databaze for your restare aperation.

To database: [IE_CLIENT =]
To a point in time: IMDSt recent pozsible |

Saurce far restore

Specify the zource and location of backup sets to restare.

" From database: I j
' From device: ID:'\DBTempIates'\IB_ELIENT.bak |
Select the backup sets to restore:
Restore | I arne | Campotiett | Typel Server | Dratabaze | Pt
v Database Full  PLDWIGDBEWODT [B_CLIENT_TEMFLATE 1
< | ]

Ok I Canicel |

4

Figure 18 Restoring a Database

9. Enter your IB_CLIENT database name in To Database:

10. Select From Device.
step 2.

Click ... to browse to the location where the database files were placed in

11. Select your database IB_CLIENT_ xxxx.BAK, where xxxx equals the renamed file from step

3.

12. Click OK. Your database will be populated.

13. Verify your information. Check the Restore box.
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14.

15.

16.

17.

Click OK.

If the database was restored successfully, it will be displayed in the database folder. If not, please
correct any errors and try again.

Repeat for the RateManager database and any SoftRater database.

Once the databases are restored to SQL Server, you will need to create or assign a SQL Server
user account for the application. This user will be used for the connection to the databases when
setting up the connections from the Insbridge Framework Administrator. Make note of the account
you want to use. This information will be entered into the Insbridge Framework Administrator.

If backups are to be allowed from the RateManager application (see page 34 for more details),
then the ibru SQL server user account must have the Disk Administrators SQL Server role.

For ease of administration, the database user should have db_owner permissions on the
IBRM_xxxx, and IB_CLIENT databases.
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STEP 6 — CONFIGURING INSBRIDGE FRAMEWORK ADMINISTRATOR

Open an Internet Explorer web browser either remotely on the local IBRU web server and browse to the
following location, replacing SERVERNAME with the actual server name:

http://SERVERNAME/ibfa/

2 Framework Administrator - Windows Internet Explorer [’L|I'E|g|
Coies v B piosahastibtaldetau s MIESE |[2]-
File Edit Wiew Favorites Tools  Help
— - . »
W I (& Framework Administratar I I f - B - = - [5reage - oo -
ORACL E msuance Insbridge Framewaork Administrator version 3.1.1 (x88)
[x] a8
= Configuration File [C:\PROGRAM FILES\ORACLE\IGBU\INSBRIDGE\FRAMEWORK\3.5.0 \Insbridge.Xml
3 softRater The Framework Administrator Web will corfigure any Insbridge Framework Configuration file (Insbridge, xmi) found on your
network. Although all Insbridge Applications may have their own version of this configuration file, we suggest that all apps
[ softbata thatreside on the same Framework Server share the same file.
[ services
£ Logs Change Config File location: Browse Update
[ security
5 Softlibraries add Subscriber
@) Hep The subscriber identifr is an unigue number that you would like to represent your company. Please consult with an
pridge supporjg#resentative if you have any questions,
# No Subscribers found.
#Add Database Connection
Creste or edit database connection. This database connection can be global to the Insbridge Framewark or unique to the
Subscribar.
IClick on the name of the connection to edit.
82 Global
# ho Cannactions found,
i)
Copyright © 2000,2008, Orade andjor its affiliates. Al rights reserved.
Done

% Local intranet 0% -

Figure 19 IBFA Home

NOTE: If you receive an access denied error message, please verify that you have given the Insbridge
user full control of the Insbridge folder.

NOTE: If you receive an IDNX denied error message, please verify that the Insbridge user has full control
over the Insbridge directory. Regedt->Insbridge Directory-> Security.

1. Click on Add Subscriber and in the next dialog.
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The Type, ID and Name information for the new subscriber is chosen by you. The Type, ID and Name are
fixed after the first time you save. These entries cannot be edited. Only the description can be edited.

NOTE: Make note of the subscriber ID humber. You may need to enter this on another IBFA or IBSS
environment.

The Subscriber ID can be a 3 or 4 digit number and must unique for each subscriber per instance of
IBFA. For example, if you have an instance of IBFA on machine A, you can create a subscriber with an ID
of 100. On machine A, if you create another subscriber, you must give that subscriber a different ID
number, say 200. If you also have an instance of IBFA on a different machine, B for example, you should
duplicate the same subscribers with the same ID numbers on machine B.

If you require assistance or are unsure of what action to take, please log a Service Request using My
Oracle Support at https://support.oracle.com/.

2 Subscriber -- Webpage Dialog @

Subscriber
Please enterfupdate your Insbridge Customer information below.

Type: |Carrier W
[ - 1010
MName: InsurCo

Desc:  Insurance Company

Save Cancel

Figure 20 Enter ID

If you receive an error message or have difficulty creating a subscriber, you may need to add the
Insbridge user to the Windows Machine Keys.

1. Go to C:\Documents and Settings\All Users\Application Data\Microsoft\Crypto\RSA\MachineKeys.
2. Right click and select Security.

3. Add the Insbridge user.

Next select the Add Database Connection link. The three databases must be added to IBFA:

e Subscriber: Global with Name: controller
e Subscriber: (Your Subscriber Name) with Name: security
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e Subscriber: (Your Subscriber Name) with Name: RM

The setups are similar for all three databases. The description information following the first example will
be the same for the other two databases.

In the next popup dialog, fill out connection information for the IB_CLIENT database using the Global
subscriber.

NOTE: If you have renamed the databases, please make note of the new names.

A Connection -- Webpage Dialog @

Connection
Database connections can be global to the Insbridge Framework or unigue to the Subscriber.

Subscriber: Global W
Mame: Contraller
Server: LocalHost Test Connection...

Server Type: | SQLServer b

Cataloaq: IE_CLIENT

Catalog Type: | Other w
Query Buffer:

Tablespace:

Schema:

User: 18]

Password: TIITITL]

Save Cancel

Figure 21 Setting up the Global Database Connection

Select Global for the Subscriber. The IB_CLIENT database is a global database and is not unique to
the subscriber. This information cannot be changed once you have saved it.

The Database Name cannot be changed once you have saved it.

The Server is the database server name or IP address which ever is resolvable by the IBRU web server.
You also can test the connection and make sure it is valid at the time of entry.
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The DB Server Type is the type of server that houses the database. Currently, RateManager and
SoftRater support SQL Server, Oracle and DB2.

The Catalog is the name of the catalog in the database. For DB2 servers, this is the System DSN Name.
The Catalog Type is the type of catalog in the database. The types available are: RateManager,
SoftRater and Other. If you are using a SQL Server, you can choose either RateManager or SoftRater. If
you are using an Oracle or DB2 database, you will need to choose Other and enter the remaining
information.

Tablespace and Schema are not required for this connection. The User is the SQL Server user (ibru)
assigned as database owner on page 20 if needed.

Add the next database. Select the Add Database Connection link again.

In the next popup dialog, fill out connection information for the IB_CLIENT database using your
subscriber ID. Name this one security.

2 Connection -- Webpage Dialog

Connection
Database connections can be global to the Insbridge Framewaork ar unique to the Subscriber.,

Subscriber: Insurance Company w
MName: SECURITY
Server: LocalHost Test Connection...

Server Type: | SQLServer i

Catalog: IBE_CLIENT

Catalog Type: | Other w
Query Buffer:

Tablespace:

Schema:

Lser: D

Password: TIITTTIT]

Save Cancel

Figure 22 Setting up the Security Database Connection
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Create a connection for RateManager using your subscriber id. Name this one rm.

NOTE: The Catalog Type must be set to RateManager when you are creating the Connection from
RateManager. If you leave it set to Other, you will receive an error.

A Connection -- Webpage Dialog

Connection
Database connections can be global to the Insbridge Framewaork or unique to the Subscriber.,

Subscriber: Insurance Company w
Mame: RM

Server: LocalHost Test Connection. ..
Server Type: | SQLServer e |

Catalog: IBRM

Catalog Type: |FETSIERET=E + |

Query Buffer:

Tablespace:

Schema:

User; 18]

Password: Il

Save Cancel

Figure 23 Setting up the RateManager Database Connection
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Next, create the default rating environments for the RateManager system.
It is recommended that you create two logical environments:
e RM —to handle rating and testing.
e QA -to hold the full packages that need to be consumed by the QA environment.

1. Browse to SoftRater»Explorer>»Subscriber name.

NOTE: This default environment is not required if performing a SoftRater node installation. Other
environments will still need to be created to load SRPs to the IBSR databases.

= Framework Administrator - Windows Internet Explorer, E\EWX\
@\TJ - ‘g, hittp:iLocalHost/IEF Ajdef ault, asp| V‘ 2| X | ‘ L -
Fle Edit View Favorites Tools Help
— : . R »
W I@Framewurmdmwsnamr ] 1 D B - heae v (Todk -
ORACLE nsuance Insbridge Framework Administrator Version 3.1.1 (x86)
Ed
Config A
=3 Insbridge
=3 SoftRater
{4 Engine
=23 Explorer Explorer Add Environment
Insurance Company N\ Adé: edit, or remove gffiranments from your Explorer configuration.
surance a
3 softData
3 services
[ Logs # Mo environments found.
[ Security
&5 softiibraries B B
Line-of-Business Management
@) Help

Your rating book of businesses are identified by an id and a description. There is no limit to the number of LOE's (line-of-
business) that your Explorer can contain,

ID - DESCRIPTION

# No Lines found.

Virtual File Server Manangement

There are times when you must download SoftRater packages from different locations. These locations require & domain
name of an ip-address of the particular server,

DESCRIPTION - SERVER - TYPE - ENVIRONMENT

# Mo file servers found.

& \

v

Copyright © 2000,2009, Orade and/or its affiiates. All rights reserved.

Done %J Local intranet F100% -

Figure 24 Create a Rating Environment

2. Click on Add Environment.
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22 Environments -- Web Page Dialog

A SoftRater configuration can support an unlimited number of
environments,

Mame: 20 _Default

Twpe: | D o

Secure: [

Save Delete | | Cancel

Figure 25 Entering Name and Environment

3. Enter a Name and select a Type. The name and type are totally dependent on how your IBRU system
is designed.

There are three types of Logical Environments:

e Development
e Quality Assurance
e Production

After you have entered your logical environment, you must define it.

Defining the Logical Environment

4. Select your company name underneath Config on the left hand side to enter the configuration
information for the newly created logical environment.

DRAC LE. Insurance Insbridge Framework Administrator

]
Config
=3 Insbridge
B[ SoftRater
|_] Engine
Ell_] Explarer Add Environment
Insurance Company Add, edit, or remove environments from your Explorer configuration.
e u
[ SoftData - DESCRIPTION
- Services
# RM - Development
EZg |
Logs _
EER s ity # BEM QA - Quality Assurance
Zallyl

Figure 26 Obtaining Environment Information
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ﬂ: Framework Administraton - Windows Internet Explorer, EHEE\

o v &) hepitonaostiBFajdfaut. asp v [4](x] | |EE

Fle Edt Wiew Favorites Tools  Help

- R : — " »
w R IféFrameworkndmimstrator l 1 MG B @ v [k pane v (0 Took v
ORACLE isurance insbridge Framework Administrator Version 3.1.1 (x86)
[x]
Packages Config |
= Insbridge 4H
-3 softRater
3 Engine N
BHER Explorer Explorer DEVELOPMENT
Insurance Company Environment(s) you may use for development purposes. Selecting an environment below will denote it as the default.
[3 SoftData
[3 services Environment: RM &
[d Logs Test Environment. ..
3 security DB Server: LocalHost
<an
== SoftLibraries DB ServerType: SQLServer -
@) Hej
J =P DB Catalog: IBRM

DE CatalogType: RateManager -

DB Query Buffer:

DE Tablespace:

DB Schema:

DE User: jin}

DB Password: LITTTTTYY

Engine Location: LOCALHOST

Engine EnvDef: Discover

Environment(s) you may use for quality assurance purposes, Selecting an environment below will denote it as the default.

Environment: RM_QA (o]
Package Location:  C:'\Program Files\Oracke\QA_SRP Test Environment...
DB Server: LocalHast
DB ServerType:
DB Catalog: 1B5R
DE CatalogType:
DB Query Buffer:
DB Tablespace: ~
< ¥ Copyright @ 2000,2009, Orade andjor its affiiates. All rights reserved.
Done %J Local intranet F100% -

Figure 27 Editing Environment

5.  Only the information shown above is required for this connection; Environment, DB Server, DB Server
Type, DB Catalog, DB Catalog Type, DB User, DB Password, Engine Type and Engine Location. The
Package Location, DB Query Buffer, DB Tablespace, DB Schema, and Engine EnvDef can remain
blank or filled out as needed. The user account should be the database owner (ibru).

For each environment, you can set up the following information:

Environment: The name of the environment. Selecting the radio button next to an environment's
name will set it up as the default environment.

Package Location: Physical location of where the packages should be stored. Click Test
Environment to run a process to validate the permissions on the directory and certify any
packages in the directory. In order for the Framework Administrator to successfully manipulate
packages in the location, it must have full control of the directory.

DB Server: The name of the server that houses the database that packages will be loaded to.
For DB2 servers, this is the DB2 Registered Alias Name. For Oracle servers, this is the server
name; either IP or DNS will work. The Database listener port number will also need to be
appended to the server name if it is something other than the default port.

The format for this is as follows: [SERVER NAME]:[PORT NUMBER]
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DB Server Type: The type of server that houses the database. Currently, RateManager and
SoftRater support SQL Server, Oracle and DB2.

DB Catalog: The name of the catalog in the database. For DB2 servers, this is the System DSN
Name. For Oracle servers, this is the instance.

DB Catalog Type: The type of catalog in the database. The types available are: RateManager,
SoftRater and Other. If you are using a SQL Server, you can choose either RateManager or
SoftRater. If you are using an Oracle or DB2 database, you will need to choose Other and enter
the remaining information.

*DB Query Buffer: For certain Database Management Systems (DBMS), system batch query
optimization is required for performance and/or because of limits on/in the system. This value will
control the maximum number of batch query operations that can be submitted to the target DBMS
in any one transaction. It is known that for certain DB2 platform versions a value of 31 is required
because of a hard software limit.

*DB Tablespace: For future use.

*DB Schema: The name of the schema that defines the structure of the database. This
information may be obtained form the Oracle DBA.

DB User: Username to access the database. This information may be obtained form the Oracle
DBA.

DB Password: Password to access the database. This information may be obtained form the
Oracle DBA.

Engine Type: The type of SoftRater engine that is used. The available options are: Windows,
WebSphere, Weblogic, or JBoss.

Engine Location: The location of the SoftRater engine. If the engine is local to the Framework
Administrator (i.e. located on the same server), leave this field as LOCALHOST. If the engine is
located on a different server, enter the name in the box.

Engine EnvDef: This field should remain blank, unless the engine is located on a different
server. If the Engine Location is set to LOCALHOST, leave this field blank. If the Engine
Location is not LOCALHOST, this should match the name of the environment on the remote
server.

NOTE: If you are using an Oracle or DB2 server, the options and requirement will be different. Please
see the Insbridge IBFA User Manual (Located in the User Guides directory) for more information.

6. After you have entered your information, scroll to the bottom of the page and click Save to save your
environments.

Oracle Insurance Insbridge Rating and Underwriting Installation and Upgrade Guide Page 47



STEP 7 — VERIFYING THE COMPONENT SERVICES

Next, you should verify the component services.
1. Click Start->Administrative Tools>Component Services.
2. Expand the Component Services option under console Root.
3. Expand Computers>My Computer->COM+ Applications.

4. Expand each Insbridge COM+ library to make sure there are components listed underneath
each compartment.

(%) Component Services

. File Action Yiew Window Help |-|ﬁ'|5|

e 7mIXE ¢ BEEPE

[_1 Consale Roak — Actions

= ;EI ;gmgggzzi:;rvices J Component Services -
0 [Mare Actions »

(= 8l My Camputer
[= || CoM+ Applications
%’ M+ Explorer
£ COM+ QC Dead Letter Queue Listener
COl+ Ukilities
Inshridge Com+ Adrministratar 3.5
Inshridge Corn+ SoftRater Engine
2 Insbridge Com+ SoftRater Library
59 System Application
“| DCOM Canfig
| Running Processes
| Distributed Transaction Coordinator
{2] Event viewer (Local)
5 Services (Local)

g

2
2y

FEHEE

Figure 28 Component Services

There should be 3 Insbridge Com+ Applications libraries:

e Insbridge Com+ Administrator 3.5
o Insbridge Com+ SoftRater Engine
e Insbridge Com+ SoftRater Library

Please note that you will not have to make any changes to any COM+ Application library. The installation
will automatically apply the Insbridge user name and password that you created earlier to the necessary
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libraries. If you change the password, you will have to change the password in all three of the Insbridge
Com+ libraries. On each library, right click, select Properties, select the Identity tab, enter in the new
password.

NOTE: If any COM+ library is missing, run the IBRU install again from the msi file and choose uninstall.
Then rerun the IBFA install. Uncheck the RateManager Install. Then check again to see if all the
libraries are listed. If they are still not listed, please log a Service Request using My Oracle
Support at https://support.oracle.com/.

Older instances of Insbridge may also have a fourth Com+ library.
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STEP 8 — ALLOWING FOR WCF ACTIVATION

WCF Activation is required for web services. RateManager makes call using IBFA web services. If this is
not activated, users will experience errors.

1. Select Start->Administrative Tools-> Server Manager.
2. Select Features Summary. Scroll through the list to verify WCF Activation has been activated.
3. If not, select Add Features. The Add Features Wizard will be displayed.

Add Features Wizard

Select one or more Features to install on this server,
Confirmation Eeatures: Description:

Progress B [¥] MET Framework 3.0 Features (Installed) =| et Sy it cleelinr Lotk fay

—1 {WCF} Activation uses ‘Windows

Results ET Framework 3.0 (Installed) Process Activation Service ko invoke
%P5 Wiewer (Installed) applications remately over the
! ion (Installed) network using protocols such as
|: BitLocker Drive Encrypion HTTP, Message Queuing, TCF, and

named pipes. Consequently,

L BITS Server Extensions applications can start and stop

|: Connection Manager Administration Kit dynamically in response ta incoming
[] Desktop Experience waork items, resulking in application
[] &roup Policy Management hosting that is more robust,

[ Internet Printing Client manageable, and efficient.

|: Internet Skorage Mame Server
[] LPR Port Manitor
|E Message Queuing (Installed)
[ Multipath 1j0
[] Metwark Load Balancing
[] Peer Mame Resalution Protocol
[ quality Windows Audio Viden Experience
[] remate Assistance
[] remate Differential Compression
Rermate Server Administration Tools (Installed)
[] removable Storage Manager LI

IMore about features

< Preyious | et = | Inistall | Zancel I

Figure 29 Selecting WCF Activation

4. Select WCF Activation. Click NEXT.
5. Confirm your selection and click INSTALL. The installation will proceed.
6. You can close out when complete.
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STEP 9 — INSTALLING THE OBI PUBLISHER

OBI Publisher is necessary for reports. If you do not plan on using reports in RateManager or IBFA, you
do not need to install this program.

1. Unzip the OBI_PUBLISHER

$ OBl Publisher Setup 9[l=1. 3

OBl Publizher (-,.....

o)

Release MNates,

cle BI Publisher (Oracle Insurance - Insbridge Install) will update the current
ko 10,1.3.4.0

Install l [ Cancel

Figure 30 Installing OBI Publisher

2. Click Install. A progress screen will be displayed.

3. When complete, click Close.

4. In order for OBI Publisher to be available to users, you must start the Insbridge Message Service.
The Insbridge Message Service can be started from IBFA or from the Server Manager.
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Starting Insbridge Services

It is also recommended that you start the Insbridge Task Manager as well. The Insbridge Task
Manager is a task queue that lists the tasks that are scheduled to be performed as well as the last
time the task was run and the status.

Insbridge Message Service Stop

The Insbridge Message Service is a Message Queue Listener that will route all batched messages to an assembly {process)
for execution. These processes may take resources and time to execute. Please consult with you system admin before
configuring the number of listeners per process.

| Batch Rating w | View Messages Edit Process Configuration

If vou see this message, you have not requested a listing from the selected spoke client. Clicking
Wiew Messages will provide yvou with a list view of the first in - first out mes=sages that are waiting to
execute.

Insbridge Task Manager Stop
The Insbridge Task Manager gives you the ahility to execute daily, weekly, hourly, ar by the minute,
View Tasks (This process may take a while to execute)

TASK LAST RUN-DATE START-TIME STATUS
Figure 31 Insbridge Services Screen
1. In IBFA, navigate to the Services page.

2. Next to Insbridge Message Service, click |23t | After a few seconds, the buttons will refresh to
indicate that the service is started.

3. Next to Insbridge Task Manager, click Start | After a few seconds, the buttons will refresh to indicate
that the service is started.

NOTE: The location and port for OBI Publisher is http://localhost:9704/xmlpserver/. This information may
be needed if you have to make a request to your company’s infrastructure and request the
security team to open the ports used by Publisher.
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Chapter 4

SOFTRATER NODE INSTALLATION

Before installing, please verify that the requirements are in
place.

The installation must be performed in the following order:
1. Install the IBRU application without RateManager.

2. Registry Access.
a. Assigning Insbridge Access.
b. Exporting Key for safe keeping.

3. Assigning permissions to the Insbridge User for the
Windows Temp Folder. This is necessary for MSMQ

4. Assigning permissions to the Insbridge User for the
Insbridge Folder

5. Creation of the QA_SR databases is next.
6. Return to IBFA and Configure:
a. Create your subscriber.
b. Create your logical environment.
c. Create your Virtual File Server connection.
7. Verifying Component Services.
8. Exporting/Importing the Registry Key
9. Allowing for WCF Activation.
10. Install OBI Publisher.

For a Windows 2008 Server installation, you must run
as Administrator.
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SOFTRATER NODE

This type of installation is also called a SoftRater node installation. A SoftRater node is an IBFA instance
on a machine that allows for packages to be copied and loaded from environment to environment. A
SoftRater node installation is done on a Windows machine and can have either a SQL Server database
or an Oracle or DB2 database.

This type of install is like a Full RateManager Installation with the RateManager option set to not install.
Also, a Virtual File Server will be set up to allow this machine to communicate with the RateManager
machine.

This installation will be the same for the Production environment with a Virtual File Server set up to allow
it to communicate with the QA machine.

SoftRater Nodes can be added any time after RateManager has been installed.
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STEP 1 — INSTALL INSBRIDGE RATING AND UNDERWRITING

1. Begin with the Oracle Insurance - Insbridge Rating and Underwriting Install file. For a 64-bit
installation, please make sure you have:

Oracle Insurance - Insbridge Rating and Underwriting (x64).exe

NOTE: The installation program requires that the installer have administrator rights on the machine
where the install is occurring.

NOTE: Please close all open applications before running the Oracle Insurance — Insbridge Rating and
Underwriting file.

2. Open the Oracle Insurance — Insbridge Rating and Underwriting file. A Welcome screen will be
displayed.

i'él Oracle Insurance - Insbridge Rating and Underwriting 4.0.1 Setup M= B3 |

4 Oracle Insurance Insbridge Rating and Underwriting

[t iz strongly recommended that you exit all \windows programs before mnning this setup program.

Click Cancel to guit the setup program, then cloze any programs you have wnning, Click Hest to
continue the inztallation,

WARMIMG: Thig program is protected by copyright law and international treaties.

|Inauthaorized reproduction or diztribution of this program, or any portion of i, may result in zevere civil
and criminal penakies, and will be prozecuted to the masimunm exstent pozsible under law.

ORACLE’

INSURANCE

Cancel |

¢ Back

Figure 32 Installing Insbridge

3. Click Next to continue.
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ji& Dracle Insurance - Insbridge Rating and Underwriting 4.0.1 Setup M= Eq |

Destination Folder ORACLE

Select a folder where the application will be installed. INSURANCE

The Wize Inztallation 'wfizard will install the files for Oracle Insurance - Inzbridge Rating
and Underwriting in the following falder.

Toinstall into a different folder, click the Browse button, and zelect anather folder.

'ou can chooge not ba inztall Oracle Insurance - Insbridge Rating and Undenwriting by
chicking Cancel to exit the ‘Wise [nstallation ‘afizard.

Dezstination Folder

C:APragram Filez\OraclehGBU nzbridgeh Browse. .. |

Wize Inztallation YWizard [R]

< Back | Hest » I Cancel

Figure 33 Entering the Destination Folder for Insbridge

Choose the location where the Insbridge installation will be located. This will be the location for all
future installations for Insbridge applications. Click Next to continue.
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ji& Dracle Insurance - Insbridge Rating and Underwriting 4.0.1 Setup M= Eq |

Logon Information DRACLE‘

The following logon information is uzed by Inshbridge. INSURANCE

Specify a uzer account ba be uzed by the application, either far running a service ar for
logging onto other serverz. Uze the Browse button to chooze wzers from pour nebwaorl.
Faor damainz, user names must be in the format of DOMAINW seM ame.

User M ame: |Insl:uriu:|ge Browsze. .. |

Pazzwiord: Ixxxxxx,mﬁ

Create Mew Lzer. . |

Wize Inztallation YWizard [R]

< Back | Hest » I Cancel

Figure 34 Logon Information

5. Enter the Insbridge user name and password for the local user account you set up earlier. The
logon information screen will be displayed. You must specify a user account to be used by the
application. Please use the Insbridge user account that you set up on page 20.

NOTE: You can Create a New user at this point, if needed. Click the Create New User button to be
placed on New User screen to setup an Insbridge user.

6. Click Next to continue.
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i'g!,l Oracle Insurance - Insbridge Rating and Underwriting 4.0.1 Setup

Select Features DRACLE

Pleaze select which featurez you would ke to install.

INSURANCE

Feature Description:
Ratebd ananer allnws husinezs uzers to create,

SR =] v| Inzbridge A ating & Undenariting
{ R atetd anager

= Wil be installed on local hard drive, rates and rules

b = v| ting engine in an

(=38 Entire Feature will be installed on local hard drive.

=1 Feature will be installed when required. t the local hard

Entire feature will be unavailable.
your hard drive.

Current location:
C:\PROGRAK FILESAORACLEMGEUMMNSERIDGEY

YWize [ngtallation wizard [R]

Digk. Cost Bezet ¢ Back | Mewt > I Cancel

Figure 35 Selecting Features for Installation

7. The next screen will list the applications to be installed. To expand the options and view details, click
on the downward arrow. All features are checked for installation. RateManager is the only one that
you will be allowed to not install. Check Entire feature will be unavailable. Click Next to continue.

Options are:

e Insbridge Rating and Underwriting:
- The default option is: Entire feature will be installed on local hard drive. This includes
IBFA.
- You will not be able to opt out of this selection.

¢ RateManager:
- The default option is: Entire feature will be installed on local hard drive.
- You will be able to opt out of this option. Select Entire Feature will be unavailable.
RateManager will not be installed. You do not need to install RateManager.

e IBFA:
- The default option is: Entire feature will be installed on local hard drive.
- You will not be able to opt out of this selection.

e Oracle Bl Publisher:
- The default option is: Entire feature will be installed on local hard drive.
- You will not be able to opt out of this selection.
- This option does not install the OBI Publisher. Only the templates required by the IBRU
application will be installed on local hard drive.
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i'e!:l‘ Oracle Insurance - Insbridge Rating and Underwriting 4.0.1 Setup M= B |

Ready to Install the Application ORACLE

Click Mext to beain installation. INSURANCE

Click the Back buttaon to reenter the inztallation information or click Cancel to exit
the wizard.

Wize Installation ‘fizard [R]

Cancel |

¢ Back

Figure 36 Ready to Install

8. A Ready to Install screen will be displayed. If you are ready, click Next. Otherwise click Back to check
the options you want to install.

i'e!:l‘ Oracle Insurance - Insbridge Rating and Underwriting Setup [_ 5] |
Updating System ORACLE
The features you selected are currently being installed.
Y v hend INSURANCE

Walidating inztall...

Wize Installation ‘fizard [R]

Figure 37 Installation Progress

Oracle Insurance Insbridge Rating and Underwriting Installation and Upgrade Guide Page 59



ji& Dracle Insurance - Insbridge Rating and Underwriting 4.0.1 Setup M= Eq |

Readme Information DRACLE‘

|nzbridge has been successfully installed. INSURANCE

Microsoft Windows 2003/2008 Server o
A full installation of Microsoft Server 20032008 is required. The following
configuration assumes that the administrator of the senver to be generally
familiar with managing a Windows server. i

Internet Information Services (lI5)

The InsBridge Rating and Underwriting System is a web based application and
requires IS to be installed before installation to facilitate the default web virtual
directaries creations.

The subcomponents of IS needed by IBRL:

. Commaon Files
. Documentation
. Internet Information Serices Snap-In |

YWize [nstallation ‘wizard®

Figure 38 Install ReadMe Screen

9. Click Finish to finish the installation. The installation should complete successfully.
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STEP 2 — CONFIGURING REGISTRY ACCESS

WARNING: If you use Registry Editor incorrectly, you may cause serious problems to the operating
system. These problems may require you to reinstall your operating system. Insbridge cannot
guarantee that you can solve problems that result from using Registry Editor incorrectly.

By default, only administrative and power user accounts have full permissions over this key. The
Insbridge user must also be given full control over the following registry key:

Assigning Permissions for the Registry Access

HKEY_LOCAL_MACHINE/SOFTWARE/Insbridge

1. Selecting Run from the Start Menu.
2. Type regedt32. Click OK. The Registry Editor will open.
3. Browse to HKEY_LOCAL_MACHINE. Select SOFTWARE->Insbridge.

& Registry Editor

File Edit Wiew Favorites Help

(=118 Computer Name Tvpe | pata
J HKEY_CLASSES_ROOT ab|(Default) REG_SZ {value not set)
[+ . HKEY_CURRENT_USER
El . HEEY_LOCAL_MACHIME
- . BCDOO0oooo0
. COMPOMNENTS
. HARDWARE
. 5AM
""" . SECURITY
=~ | SOFTWARE
< Classes
- Clients
- L Ghu
- Hewlett-Packard
Expand
Mew 3
Find...

Delete
Rename

P 0 O e O O e e O O e O e O e O e

Exp

Copy Key Mame

[#- [ S¥STEM
[+ | HKEY_USERS
[#- | HEEY_CURRENT_CONFIG

|ComputeriHKEY_LOCAL_MACHINE\SOFTWAREInsbridge 4

Figure 39 Configure Registry Access Windows Server
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4. Right click and select Permissions.
Click Add.

6. On the Select Users or Groups popup, you can leave the defaults for the Object Types and
Locations or enter the values you require.

o

Select Users or Groups ﬂ

Select thiz object type:

ILlsers, Groups, or Buil-in security principals Object Topes...

Erarn thig location;
|WINSF|F'EIEI1 Locations...

Enter the object namesz to zelect [examples]:
inzbridgel Check Mames

i

Advanced. .. | 0k, I Cancel |

4

Figure 40 Entering the User

7. Enterin the user name (Insbridge) and click Check Names. If the user name is found, it will be
listed. If the name is not found, an error screen will be displayed. Cancel out and to return to the
Select Users or Groups popup. Click Advanced to search. To search the directory, click Find
Now and scroll through the list until you find the user name you need. If the user name is not
listed, return to User Accounts and verify the user name was created.

8. Once the name is listed, click OK.
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9.

. Permissions for Inshridge
Security |

Group or user names:

528 CREATOR OWHER

52 SWSTEM

l Insbridge [*WIMSRPO01 4 nebridge]

52 Administrators [4/INSRPO0T\Administrators]
52 Users WINSRPOOTS zerg)

Add... | Bemove |

Pemizzions for |nsbridoe Sl Deny

Full Contral O
Read O
S pecial permizsions O O

For zpecial permizzions or advanced zettings, Advanced |
click Advanced. =

| earn about access conbol and permiszions

k. I Cancel | Apply

Figure 41 Applying Permissions for Insbridge User

On the Permissions screen, make sure the Insbridge user is highlighted and check to give Full

Control to the entire Insbridge key.

10. Click OK.

Export Insbridge Registry Key for Backup

The Insbridge registry key located in HKEY_LOCAL_MACHINE->SOFTWARE->Insbridge is used to
store all information for proper encryption of the SoftRater Packages (SRPs). This registry key should be
exported to a text file and stored in a safe location off the server. In the event of a catastrophic server
failure and the IBRU system needs to be reinstalled, you will need, and/or be requested to send to

Insbridge, your registry key.

PN~

Select the Insbridge key: HKEY_LOCAL_MACHINE->SOFTWARE->Insbridge.

Right click and select Export.
Select a storage location for the file and Save.

For a SoftRater Node ONLY install, DO NOT close out of Registry Editor. After you create an
Insbridge subscriber, you will need to export/import the registry key.
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STEP 3 — ASSIGNING PERMISSIONS — TEMP FOLDER FOR MSMQ

Assigning Permissions for a Windows Temp Folder for MSMQ

1.

Open Documents. Find the WINDOWS folder, most likely on your C drive.

2. Right click the Windows—->Temp folder.

; }v | .+ Computer = Local Disk (C:) = Windows = Temp - - lml ISearch l‘_ﬂj
File Edit Wiew Tools Help
Organize v = Views - ©
Favarite Links MName = |v| Dake modified |v| Tvpe |v| Size |v| Tags |v|
| TestEngDat64 2[8f2010 12:54 PM  File Folder
[ Documents || DMIZFE tmp /312010 10:30 AM  THP File OKE
'.E Pickures || DMIFCES. kmp 2faf2010 10:30 AM TMP File OKB
"[] Plusic | Fratsgmafile0n. sqm 7/12/2010 12:58... SOMFile 1 KB
Mare 3 | Pwtsqrafiledl.sqm 7/19/2010 1116 PM SQM File 1 KB
| Fratsgmfile02,sqm 7/26/2010 1:34 PM S0M File 1 KB
Falders w L |Fetsgmfile03.sgm g/2i2010 1:47 PM - S0QM File 1 KB
Fwtsgmfile04. sgm 8/9/2010 1:53PM  S0QM File 1 KB
| Tasks ;I -—F " , ’
| Pwtsgmfileds. sqm 3/16/2010 1:54 PM S0QM File 1 KB
/ M | Pwtsqrafile0e, sqm 8/23/2010 2:02 PM SQM File 1 KB
I || Ftsgmfile?.sqm 8/30/2010 2:07 PM SQM File 1KB
Explare | Pwksqrafile0s, sqm 4/1212010 3:23 PM S0QM File 1 KB
Cpen J | Fratsgmfile0,sqm 4/19/2010 3:28 PM S0OM File 1 KB
| Pwtsgrafile 10, sqm 4/26/2010 3141 PM S0QM File 1 KB
) Share... || Prutsamfile11,5qm S/6/Z010 9:35 &M SOM File 1KE
oD [ Scan For threats. ., || Pwtsgmfile12.sqm 5/13/2010 9:50 AM  SQM File 1 KB
=] l_.'l" Mekwo ) ) | Fwksqrafile13.sqm 5/24/2010 11:12.,. SQM File 1 KB
i p3pq  [LEStOrE previous versions || Fwtsamfile14.sqm 5/31/2010 11:27... SQM File 1KB
M| aMs| Send To | Pwtsqrafile 15, sqm B/7f2010 11:42 AM S0QM File 1 KB
L o, | Fratsgmfile16.5qm 6/14/2010 11:58... SOM File 1 KB
1M s CEW __FwtsqmF!Iel?.sqm B/21f2010 12:06.,. 3S0M F!Ie 1 KB
(M A | Fratsgmfile18,5qm glzafz010 12:21,,.  SGMFile 1 KB
M gREl  Delets || Pwtsgrafile 19, sqm _ F/Si2010 12:37 PM SOM File 1 KB
M asc . | |FxsTIFFDebuglogFile  4/29/2010 9:35 AM  Text Document OKE
M ASE e
L
s I -|

Figure 42 Assigning Permissions for the Insbridge User on Windows Temp

o0k w

® N

Select Properties. The Temp Properties screen will open.

Select the Security tab.

Click Edit.

On the Permissions for Temp screen, select the Insbridge user and click Add. If the Insbridge
user is not found, cancel out and return to the Local Users and Groups area in Server Manager
and verify the Insbridge user was created.

Update the permissions. The Insbridge user requires Full Control.
Click OK to close the Permissions for Temp screen.

Click OK to close the Temp Properties screen.
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STEP 4 — ASSIGNING PERMISSIONS — INSBRIDGE FOLDER

Assigning Permissions for an Insbridge Folder Location

1. Open Documents. Locate the INSBRIDGE folder, most often the Insbridge folder is located at:
C:\Program Files\Oracle\IGBU\Insbridge.

2. Right click the INSBRIDGE folder.

'ﬁ Insbridge _ [O0]
Gl\ )v | . = Local Disk (C:) = Program Files » Oracle » IGBU ~ Insbridge - v l‘ﬂJ ISearch ¥
File Edit “iew Tools Help
Organize v =5 Wiews ¥ (7]
Eavorite Links Mame I"I Date modified IvI Type IvI Size I'I Tags I"I
L COM+ S/3002010 6:50PM  File Folder
[f) pocuments | Framewark 4/29/2010 9:54 AM  File Falder
[E pictures = 4/29(2010 9:54 AWM File Falder
F[}‘l Music . SoftRater 4/29/2010 9:54 AM  File Folder
More s | iebs 412902010 3:54 AM  File Folder
Falders v
= . Cracle ﬂ
= | IEEU
Collapse
[+]
& Explare
Jpen
Share. ..
J Pa K Scan for threats, ..
. Ref
| Wi Restore previous versions
Wit gend To »
, Users
J windo s
o ovp Dy 9P
= %¥ Metwork, Delete
W& AJACOL  Rename
B
cl, AMSDEM R
[ 8 AMSDE:

Figure 43 Assigning Permissions for the Insbridge User on Insbridge

3. Select Properties. The INSBRIDGE Properties screen will open.

4, Select the Security tab.

5. Click Edit.

6. On the Permissions for INSBRIDGE screen, select the Insbridge user and click Add. If the
Insbridge user is not found, cancel out and return to the Local Users and Groups area in Server
Manager and verify the Insbridge user was created.

7. Update the permissions. The Insbridge user requires Full Control.

8. Click OK to close the Permissions for INSBRIDGE screen.
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M 1nsbridge Properties I
.Generall Sharing Security | Previous Versinnsl Eustu:umizel

Object name:  C:%Pragram Files\Oracles GBLU N nebridge

Erl:lup Or LIEEr names;

5% CREATOR OWNER

52 SYSTEM

t Inzbridge [*/INSEPO0T 4 nsbridge]

-
W2 & Arninisteatars DS EPIIO S & drninizteatars] il
1 | F
To change permizziong, click Edi. o Edit.. |

Permizzions far Insbrdge Allova Derm

Full control

b odifye

Read & execute
List folder contents
Read

Write

Far zpecial permizsions or advanced zettings,
click Advanced.

AR LN NN

|_ILI_I*_

Advanced

| earn about access conbral and permizsions

k. I Cancel | Apply |

Figure 44 Setting Permission for Insbridge Folder

9. Click OK to close the Temp Properties screen
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STEP 5 — RESTORING A SOFTRATER DATABASE IN SQL SERVER

Because many corporate environments have a separation between the system administrator and the
database administrator, the following process may require both administrators’ access and permissions.
Make sure you have a SQL Server account called ibru.

NOTE: If you do not have database permissions, you will not be able to perform the following database
procedures.

NOTE: If you are unsure how to perform a database restore, please consult with your database
administrator.

Currently supported is the default SQL Server collation using SQL_Latin1_General_ CP1_CIl_AS and sort
order plus case sensitivity using Latin1_General_BIN as the server collation. The security database
(IB_CLIENT) supports the default SQL Server collation using SQL_Latin1_General_CP1_CI_AS. The
RateManager and SoftRater databases can use either case sensitive or non-case sensitive. Please check
with Oracle Insurance for any questions regarding database server sort orders or collations.

1. Located in the Insbridge Installation Directory:

SQL Server
- SoftRater — IBSR
0 Latin1_General_BIN
= DATABASE_BACKUP_IBSR_TEMPLATE_CASE_SENSITIVE.bak
o0 SQL_Latin1_General_CP1_CI_AS
» DATABASE_BACKUP_IBSR_TEMPLATE.bak
o Usp IBSR v03.13.0.sql

2. Select the RateManager backup file you want to use, case sensitive or non-case sensitive. The
SoftRater — IBSR file is only non-case sensitive.

3. Copy the file to an appropriate database folder on the machine where SQL Server is installed.
For example, [Drive]:\Program Files\Insbridge\Databases. If you are unsure of a location, please
consult with your database administrator.

4. Rename the file. It is not required but it is strongly suggested that the database file name be
changed from TEMPLATE to something that defines the database more accurately. At a
minimum, it is recommended that you remove “ TEMPLATE” from the name. You can change the
names after they have been restored also.

5. Open the SQL Server Management Studio either on the server or remotely using either an
administrative account with sa privileges or as the sa account.

NOTE: If you do not have SQL Server Management Studio, check to see that the SQL Server Client has
been installed. For a SQL Server install, you must have the SQL Server Client installed.
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Zip
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Log OFF @ Shut Down

Figure 45 Restoring a Database to SQL Server

6. Go to Databases.

icrosoft SOL Server Management Studio - [Object Explorer Details]

L_‘ggi File Edit Wew Tools Window Community Help -F X
Quewoey || BBE/IE SIS E S BB,
2 - 7 X

EaT

Conrect~ | @3 m T [Z]
= [ﬂ Southern (0L Server 9.0,4035 - sa) \1
NS Databases
w Mew Database...

[ Security SOUTHERM\Databases 131 Item(s)

[ Server O Attach...

[l Replicati

[ Manag | Restore Database., . =

[ Matificati Restore Files and Filegroups. .. stem Databasss

SQL Ser

|ﬁ Reports D atabase Snapshots
Rater_auditing
Refresh _—
| | o

Ready v

Figure 46 Right Click to Restore Database
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7. Right click on Databases.

8. Select Restore Database... A separate screen will be displayed.

I Restore Database - IB_CLIENT

Select "_;S Script - m Help

% General

=] 3

1 Oplions

Server
Server

Connection:
za

4 View connection properties

Degtination for restore

Select ar type the name of a new ar existing databaze for your restare aperation.

To database: [IE_CLIENT =]
To a point in time: IMDSt recent pozsible |

Saurce far restore

Specify the zource and location of backup sets to restare.

" From database: I j
' From device: ID:'\DBTempIates'\IB_ELIENT.bak |
Select the backup sets to restore:
Restore | I arne | Campotiett | Typel Server | Dratabaze | Pt
v Database Full  PLDWIGDBEWODT [B_CLIENT_TEMFLATE 1
< | ]

Ok I Canicel |

4

Figure 47 Restoring a Database

9. Enter your IBSR database name in To Database:.

10. Select From Device.
step 2.

Click ... to browse to the location where the database files were placed in

11. Select your database IBSR_ xxxx.BAK, where xxxx equals the renamed file from step 3.

12. Click OK. Your database will be populated.

13. Verify your information. Check the Restore box.
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14.

15.

16.

Click OK.

If the database was restored successfully, it will be displayed in the database folder. If not, please
correct any errors and try again.

Once the database is restored to SQL Server, you will need to create or assign a SQL Server
user account for the application. This user will be used for the connection to the databases when
setting up the connections from the Insbridge Framework Administrator. Make note of the account
you want to use. This information will be entered into the Insbridge Framework Administrator.

For ease of administration, the database user should have db_owner permissions on the
IBSR_xxxx database.
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STEP 6 — CONFIGURING INSBRIDGE FRAMEWORK ADMINISTRATOR

Open an Internet Explorer web browser either remotely on the local IBRU web server and browse to the
following location, replacing SERVERNAME with the actual server name:

http://SERVERNAME/ibfa/

/.: Framework Administrator - Windows Internet Explorer E”Elgl

- [ hepuifLocahastbafdeFaut. asp 3 [#][x] | |EE

- -

Ele Edt Wew Favorites Tools Help

— = . »
W dr I {& Framework Administrator ] I fi -~ B - - [=reaoe - GiTooks -
ORACL_E nsurance Insbridge Framework Administrator Version 3.1.1 (x86)
[x] A
= Configuration File [C:\PROGRAM FILES\ORACLE\TGBU\THSBRIDGE\FRAMEWORK\3.5.0\Insbridge Xml]
3 SoftRater The Framework Administrator Web will configure any Insbridge Framework Configuration file (Insbridge. xml) found on your
network. Although all Insbridge Applications may have their own version of this configuration file, we suggest that all apps
3 softbata thatreside on the same Framework Server share the same file.
[3 services
ge Config : .. || Update
3 Logs Change Config File location Browse pd:
3 security
4 Softiibraries Add Subscriber
@) Help The subscriber identifffr is an unique number that you would ke to represent your company. Please consult with an
bridoe supporjghresentative if you have any questions.
# o Subscribers found,
Add Database Connection
Creste or edit database connection, This databass connection can be glabal to the Insbridge Framework o uniqus to the
Subscriber.
IClick on the name of the connection to edit.
Global
# 1o Connections found.

53

Copyright & 2000,2003, Oracle andjor its affiiates. Al rights reserved.

Done % Local intranet F100%

Figure 48 IBFA Home

NOTE: If you receive an access denied error message, please verify that you have given the Insbridge
user full control of the Insbridge folder.

NOTE: If you receive an IDNX denied error message, please verify that the Insbridge user has full control
over the Insbridge directory. Regedt->Insbridge Directory-> Security.

4. Click on Add Subscriber and in the next dialog.
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http://servername/ibfa/

The Type, ID and Name information for the new subscriber is chosen by you. The Type, ID and Name are
fixed after the first time you save. These entries cannot be edited. Only the description can be edited.

NOTE: Use the same subscriber ID number as in the Development environment.

The Subscriber ID can be a 3 or 4 digit number and must unique for each subscriber per instance of
IBFA. For example, if you have an instance of IBFA on machine A, you can create a subscriber with an ID
of 100. On machine A, if you create another subscriber, you must give that subscriber a different ID
number, say 200. If you also have an instance of IBFA on a different machine, B for example, you should
duplicate the same subscribers with the same ID numbers on machine B.

If you require assistance or are unsure of what action to take, please log a Service Request using My
Oracle Support at https://support.oracle.com/.

A Subscriber -- Webpage Dialog

Subscriber
Flease enterfupdate your Insbridge Customer information below,

Type: |Carrier hd
1D: 1010
MName: InsurCo

Desc: Insurance Company

Save Cancel

Figure 49 Enter ID

If you receive an error message or have difficulty creating a subscriber, you may need to add the
Insbridge user to the Windows Machine Keys.

1. Go to C:\Documents and Settings\All Users\Application Data\Microsoft\Crypto\RSA\MachineKeys.
2. Right click and select Security.

Add the Insbridge user.

NOTE: If you have renamed the databases, please make note of the new names.
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Next, create the default rating environments for the RateManager system.
It is recommended that you create one logical environment:

o SR —toidentify the location of the local SRPs and the QA IBSR DB.

1. Browse to SoftRater»Explorer»Subscriber name.

/= Framework Administrator, - Windows Internet Explorer l‘;‘@”i‘
@ e - | ] httpfLocaliost/TBF ajdeFault.aspx| DS [2]-
Eile Edit Wiew Favaorites Tools  Help
— : . m »
w o I@Framewnrk Administratar l } v B v kpane - (0 Took -
ORALCL_E nsurance Insbridge Framework Administrator Version 3.1.1 (x86)
[
Config
B3 Insbridge
-3 SoftRater
[l Engine
=3 Explorer Explorer Add Environment
Insurance Compan Add, edit, or remove emfronments from your Explorer configuration.
3 SeftData
3 services
[ Logs # Mo environments found.
[ security
&5 softiibraries . .
Line-of-Business Management
Q) e Your rating book of businesses are identified by an id and 5 description. There is no limit to the number of LOB's (ine-of-
business) that your Explarer can contain.
# No Lines found.
Virtual File Server Manangement
There are times when you must download SoftRater packages from different locations. These locations require a domain
name of an ip-address of the particular server.
# Mo file servers found.
< | @ Copyright © 2000,2009, Orade and/or its affiliates. Al rights reserved.
Done % Local intranet H100% -

Figure 50 Create a Rating Environment

2. Click on Add Environment.

Oracle Insurance Insbridge Rating and Underwriting Installation and Upgrade Guide Page 73



22 Environments -- Web Page Dialog

A SoftRater configuration can support an unlimited number of
environments,

Mame: 20 _Default

Twpe: | D o

Secure: [

Save Delete | | Cancel

Figure 51 Entering Name and Environment

3. Enter a Name and select a Type. The name and type are totally dependent on how your IBRU system
is designed.

There are three types of Logical Environments:

e Development
e Quality Assurance
e Production

After you have entered your logical environment, you must define it.

Defining the Logical Environment

4. Select your company name underneath Config on the left hand side to enter the configuration
information for the newly created logical environment.

DRAC LE. Insurance Insbridge Framework Administrator

]
Config
=3 Insbridge
B[ SoftRater
|_] Engine
Ell_] Explarer Add Environment
Insurance Company Add, edit, or remove environments from your Explorer configuration.
e u
[ SoftData - DESCRIPTION
- Services
# RM - Development
EZg |
Logs _
EER s ity # BEM QA - Quality Assurance
Zallyl

Figure 52 Obtaining Environment Information
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ﬂ: Framework Administraton - Windows Internet Explorer, EHEE\

o v &) hepitonaostiBFajdfaut. asp v [4](x] | |EE

Fle Edt Wiew Favorites Tools  Help

- R : — " »
w R IféFrameworkndmimstrator l 1 MG B @ v [k pane v (0 Took v
ORACLE isurance insbridge Framework Administrator Version 3.1.1 (x86)
[x]
Packages Config |
= Insbridge 4H
-3 softRater
3 Engine N
BHER Explorer Explorer DEVELOPMENT
Insurance Company Environment(s) you may use for development purposes. Selecting an environment below will denote it as the default.
[3 SoftData
[3 services Environment: RM &
[d Logs Test Environment. ..
3 security DB Server: LocalHost
<an
== SoftLibraries DB ServerType: SQLServer -
@) Hej
J =P DB Catalog: IBRM

DE CatalogType: RateManager -

DB Query Buffer:

DE Tablespace:

DB Schema:

DE User: jin}

DB Password: LITTTTTYY

Engine Location: LOCALHOST

Engine EnvDef: Discover

Environment(s) you may use for quality assurance purposes, Selecting an environment below will denote it as the default.

Environment: RM_QA (o]
Package Location:  C:'\Program Files\Oracke\QA_SRP Test Environment...
DB Server: LocalHast
DB ServerType:
DB Catalog: 1B5R
DE CatalogType:
DB Query Buffer:
DB Tablespace: ~
< ¥ Copyright @ 2000,2009, Orade andjor its affiiates. All rights reserved.
Done %J Local intranet F100% -

Figure 53 Editing Environment

5.  Only the information shown above is required for this connection; Environment, DB Server, DB Server
Type, DB Catalog, DB Catalog Type, DB User, DB Password, Engine Type and Engine Location. The
Package Location, DB Query Buffer, DB Tablespace, DB Schema, and Engine EnvDef can remain
blank or filled out as needed. The user account should be the database owner (ibru).

For each environment, you can set up the following information:

Environment: The name of the environment. Selecting the radio button next to an environment's
name will set it up as the default environment.

Package Location: Physical location of where the packages should be stored. Click Test
Environment to run a process to validate the permissions on the directory and certify any
packages in the directory. In order for the Framework Administrator to successfully manipulate
packages in the location, it must have full control of the directory.

DB Server: The name of the server that houses the database that packages will be loaded to.
For DB2 servers, this is the DB2 Registered Alias Name. For Oracle servers, this is the server
name; either IP or DNS will work. The Database listener port number will also need to be
appended to the server name if it is something other than the default port.

The format for this is as follows: [SERVER NAME]:[PORT NUMBER]
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DB Server Type: The type of server that houses the database. Currently, RateManager and
SoftRater support SQL Server, Oracle and DB2.

DB Catalog: The name of the catalog in the database. For DB2 servers, this is the System DSN
Name. For Oracle servers, this is the instance.

DB Catalog Type: The type of catalog in the database. The types available are: RateManager,
SoftRater and Other. If you are using a SQL Server, you can choose either RateManager or
SoftRater. If you are using an Oracle or DB2 database, you will need to choose Other and enter
the remaining information.

*DB Query Buffer: For certain Database Management Systems (DBMS), system batch query
optimization is required for performance and/or because of limits on/in the system. This value will
control the maximum number of batch query operations that can be submitted to the target DBMS
in any one transaction. It is known that for certain DB2 platform versions a value of 31 is required
because of a hard software limit.

*DB Tablespace: For future use.

*DB Schema: The name of the schema that defines the structure of the database. This
information may be obtained form the Oracle DBA.

DB User: Username to access the database. This information may be obtained form the Oracle
DBA.

DB Password: Password to access the database. This information may be obtained form the
Oracle DBA.

Engine Type: The type of SoftRater engine that is used. The available options are: Windows,
WebSphere, Weblogic, or JBoss.

Engine Location: The location of the SoftRater engine. If the engine is local to the Framework
Administrator (i.e. located on the same server), leave this field as LOCALHOST. If the engine is
located on a different server, enter the name in the box.

Engine EnvDef: This field should remain blank, unless the engine is located on a different
server. If the Engine Location is set to LOCALHOST, leave this field blank. If the Engine
Location is not LOCALHOST, this should match the name of the environment on the remote
server.

NOTE:

If you are using an Oracle or DB2 server, the options and requirement will be different. Please
see the Insbridge IBFA User Manual (Located in the User Guides directory) for more information.

After you have entered your information, scroll to the bottom of the page and click Save to save your
environments.

Adding a Virtual File Server

Virtual file server management allows you to set up a link to servers that are in different locations where
packages can be downloaded. In a typical QA environment, you will set up a Virtual File Server to point
back to the QA logical environment that you created in your RateManager Development environment.
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This step is necessary if you want to copy and load packages from environment to environment, however,
if you do not have the information ready. You can do this at a later time.

1. From the Configuration Page, click the Virtual File Server Management link.

¥irtual File Server Manangement

There are ktmes when vou musk download SoftRater packages from different locations, These locations require a domain
name of an ip-address of the particular server,

DESCRIPTION - SERYER - TYPE - ENVIRONMENT

# Mo file servers found,
Figure 54 Virtual File Server Management Screen

2. This will open the Virtual File Server Management window.

2 Virtual File Server -- Web Page Dialog

¥irtual File Server Management
Remote SRP Server Management

&dd

# Mo file servers found,

Delete Selected Server(s) _ Edit Selected Server

Save Cancel

Figure 55 Virtual File Server Management Window

3. Enter the name of the server and a description. Take care when entering the server name. This
field cannot be edited. If you have made a mistake, you must delete and re-enter.

4. Click| add | to add the server to the list. Enter in as many servers as you need.

5. When you are finished, click Save to save your work and return to the previous screen.
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STEP 7 — VERIFYING THE COMPONENT SERVICES

Next, you should verify the component services.
1. Click Start->Administrative Tools>Component Services.
2. Expand the Component Services option under console Root.
3. Expand Computers>My Computer->COM+ Applications.

4. Expand each Insbridge COM+ library to make sure there are components listed underneath
each compartment.

(%) Component Services

. File Action Yiew Window Help |-|ﬁ'|5|

e 7mIXE ¢ BEEPE

[_1 Consale Roak — Actions

= ;EI ;gmgggzzi:;rvices J Component Services -
0 [Mare Actions »

(= 8l My Camputer
[= || CoM+ Applications
%’ M+ Explorer
£ COM+ QC Dead Letter Queue Listener
COl+ Ukilities
Inshridge Com+ Adrministratar 3.5
Inshridge Corn+ SoftRater Engine
2 Insbridge Com+ SoftRater Library
59 System Application
“| DCOM Canfig
| Running Processes
| Distributed Transaction Coordinator
{2] Event viewer (Local)
5 Services (Local)

g

2
2y

FEHEE

Figure 56 Component Services

There should be 3 Insbridge Com+ Applications libraries:

e Insbridge Com+ Administrator 3.5
o Insbridge Com+ SoftRater Engine
e Insbridge Com+ SoftRater Library

Please note that you will not have to make any changes to any COM+ Application library. The installation
will automatically apply the Insbridge user name and password that you created earlier to the necessary
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libraries. If you change the password, you will have to change the password in all three of the Insbridge
Com+ libraries. On each library, right click, select Properties, select the Identity tab, enter in the new
password.

NOTE: If any COM+ library is missing, run the IBRU install again from the msi file and choose uninstall.
Then rerun the IBFA install. Uncheck the RateManager Install. Then check again to see if all the
libraries are listed. If they are still not listed, please log a Service Request using My Oracle
Support at https://support.oracle.com/.

Older instances of Insbridge may also have a fourth Com+ library.

STEP 8 - EXPORT AND IMPORT SUBSCRIBER REGISTRY KEY FOR
SOFTRATER NODE INSTALLATION

The Insbridge registry key located in HKEY_LOCAL_MACHINE->SOFTWARE->Insbridge is used to
store all information for proper encryption of the SoftRater Packages (SRPs). This registry key should be
exported using regedt32 to a text file and stored in a safe location off the server and/or sent to Insbridge
in the event of a catastrophic server failure and the IBRU system needs to be reinstalled.

1. On the server where RateManager is installed, open regedt32, then navigate to the
HKEY_LOCAL_MACHINE->SOFTWARE->Insbridge> Subscribers>SUBSCRIBER_NAME
where SUBSCRIBER_NAME equals the name as entered on page 71.

2. Select the Registry menu option and select export.
3. Enter the key file name and save this to the desktop.
4. Copy this file to the SoftRater Node on the receiving IBFA.

5. Double-click this file. You will be asked if you wish to continue to import this data into the registry.
Select Yes.

6. If the import was successful, then you will receive a report that it was successfully installed. If the
import fails, please correct the error and try again.

Now the encryption on the RateManager server where the SRPs are created and the SoftRater Node
where the SRPs are loaded match.
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STEP 9 — ALLOWING FOR WCF ACTIVATION

WCF Activation is required for web services. RateManager makes call using IBFA web services. If this is
not activated, users will experience errors.

1. Select Start->Administrative Tools-> Server Manager.
2. Select Features Summary. Scroll through the list to verify WCF Activation has been activated.
3. If not, select Add Features. The Add Features Wizard will be displayed.

Add Features Wizard

Select one or more Features to install on this server,
Confirmation Eeatures: Description:

Progress B [¥] MET Framework 3.0 Features (Installed) =| et Sy it cleelinr Lotk fay

—1 {WCF} Activation uses ‘Windows

Results ET Framework 3.0 (Installed) Process Activation Service ko invoke
%P5 Wiewer (Installed) applications remately over the
! ion (Installed) network using protocols such as
|: BitLocker Drive Encrypion HTTP, Message Queuing, TCF, and

named pipes. Consequently,

L BITS Server Extensions applications can start and stop

|: Connection Manager Administration Kit dynamically in response ta incoming
[] Desktop Experience waork items, resulking in application
[] &roup Policy Management hosting that is more robust,

[ Internet Printing Client manageable, and efficient.

|: Internet Skorage Mame Server
[] LPR Port Manitor
|E Message Queuing (Installed)
[ Multipath 1j0
[] Metwark Load Balancing
[] Peer Mame Resalution Protocol
[ quality Windows Audio Viden Experience
[] remate Assistance
[] remate Differential Compression
Rermate Server Administration Tools (Installed)
[] removable Storage Manager LI

IMore about features

< Preyious | et = | Inistall | Zancel I

Figure 57 Selecting WCF Activation

4. Select WCF Activation. Click NEXT.
5. Confirm your selection and click INSTALL. The installation will proceed.
6. You can close out when complete.
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STEP 10 — INSTALLING THE OBI PUBLISHER

OBI Publisher is necessary for reports. If you do not plan on using reports in IBFA, you do not need to
install this program.

1. Unzip the OBI_PUBLISHER

$ OBl Publisher Setup 9[l=1. 3

0B1 Publizher (

i

o)

Release MNates,

his Cracle BI Publisher {Cracle Insurance - Insbridge Install) will update the current
release to 10,1,3.4.0

Install l [ Cancel

Figure 58 Installing OBI Publisher

2. Click Install. A progress screen will be displayed.
3. When complete, click Close.

4. In order for OBI Publisher to be available to users, you must start the Insbridge Message
Service. The Insbridge Message Service can be started from IBFA or from the Server Manager.
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Starting Insbridge Services

It is also recommended that you start the Insbridge Task Manager as well. The Insbridge Task
Manager is a task queue that lists the tasks that are scheduled to be performed as well as the last
time the task was run and the status.

Insbridge Message Service Stop

The Insbridge Message Service is a Message Queue Listener that will route all batched messages to an assembly {process)
for execution. These processes may take resources and time to execute. Please consult with you system admin before
configuring the number of listeners per process.

| Batch Rating w | View Messages Edit Process Configuration

If vou see this message, you have not requested a listing from the selected spoke client. Clicking
Wiew Messages will provide yvou with a list view of the first in - first out mes=sages that are waiting to
execute.

Insbridge Task Manager Stop
The Insbridge Task Manager gives you the ahility to execute daily, weekly, hourly, ar by the minute,
View Tasks (This process may take a while to execute)

TASK LAST RUN-DATE START-TIME STATUS
Figure 59 Insbridge Services Screen
1. In IBFA, navigate to the Services page.

2. Next to Insbridge Message Service, click |23t | After a few seconds, the buttons will refresh to
indicate that the service is started.

3. Next to Insbridge Task Manager, click Start | After a few seconds, the buttons will refresh to indicate
that the service is started.

NOTE: The location and port for OBI Publisher is http://localhost:9704/xmlpserver/. This information may
be needed if you have to make a request to your company’s infrastructure and request the
security team to open the ports used by Publisher.
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Chapter 5
INCORPORATING AN ORACLE DB

The Windows environment utilizing an Oracle database example will displayed by machine and contains
3 application servers and 2 database servers. There are still three environments; development, QA and

Production. The Oracle database server will contain two separate databases. Clear and precise naming
of the associated databases is recommended.

RateManager and IBFA must run on a Windows Server machine. No other operating system will be
required. RateManager will be loaded in one environment only.

THE SETUP

1. All three application machines would create the same subscriber ID. The subscriber ID must be
uniform across all environments.

2. In the Development environment:
a. RateManager and IBFA/SR-WIN would be located on the same Windows machine.
b. OBI Publisher is installed for reports to be created.
c. On the IBFA/SR-WIN for this environment, three database connections would be created
and two logical environments would be created.
d. Two databases would be restored to a separate SQL Server machine.

3. Inthe QA environment:
a. IBFA/SR-WIN would be located on a Windows machine.
b. OBI Publisher is installed for reports to be created.
c. The Oracle client would be run.
d. On the IBFA/SR-WIN for this environment, one logical environment and one virtual file
server would be created.
e. One database would be restored to a separate Oracle DB.

4. Inthe Production environment:
a. IBFA/SR-WIN would be located on a Windows machine.
b. OBI Publisher is installed for reports to be created.
c. The Oracle client would be run.
d. On the IBFA/SR-WIN for this environment, one logical environment and one virtual file
server would be created.
e. One database would be restored to a separate Oracle DB.

1. The Oracle Server:
a. Requires that the Oracle DBA run the DDLs.
b. Requires that the Oracle DBA create a DT table for each line of business in each of the
two database created. The subscriber ID and line of business number will be required.

This is a basic Windows setup with the addition of an Oracle database. You can add another environment

if necessary. For example, if you wanted to create a training environment or a second level of testing, you
could add these environments in where you wanted.
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Example

IBRU Installation/Setup — Windows Incorporating an Oracle DB

Development saL QA G Production
Windows Windows Windows
Rating and Rules i ) . .
Aﬁlhnring Ze&_u'[r,e; Test Rating DE for SRPs Production Rating
TR Lot RUN: INSTALL:
'E’,:.: IBFA, DOLe IBFA
OBl Publisher OBl Publisher OBl Publisher
CREATE RESTORE:
SUBSCRIBER RUN: eRElE RUN:
Must be the same IB_CLIENT
in all ervironments security Cracle Cliant Ll tati-lgfﬂa EE Oracle Client
ADD RESTORE: CREATE CREATE
DB Connecticns: SUBSCRIBER SUBSCRIEER
RM hust be the same Must be the same
Controller Rating/Rules in all environments CREATE: in all envircnments
Security —
REM SR -the
IBSR DB for QA .
CREATE: CREATE:
) Logical
CREATE: Logical . Ervironments:
Environments:
Envﬁlr[:alnts- SR - to identify the (g SRI D—c;ﬂﬁéiegftmm
' location of the Products |
jocal SRPs and raduction - the local RPs and
RM —to handle the 0A IBSR DB IBSR DE for the Production
testing/rating. & Praduction IBSR DB.
QA_SR - This o o
environment
contains the full
packages to be Ergm= CREATE:
consumed by A .
\___/"—'_-“‘ " VFs:
Tothe QA_SR
environment on en:i?;lrrﬁ;l?un
the Devek_:pment the QA machine
machine
PURPOSE For
setting up this
Physical
Environment
PURPOSE For
S0L Server is m‘gzg '-I'P ‘I’“S
required for RM and yslcal
::It?rfgoﬁs ch?sr IBe_qCLIENT. The S0L Environment PURPOSE For PURPOSE For
Physical Server should be on i . ) setting up this setting up this
Environment a separate machine. This emaronment is Physical Physical
These DBs will for (real-time) Environment Environment
. . oduction rating.
Th t connect to the pr
is fcli tahn; I:eosr:inl:; I::f Development When users send The Oracle DB will This environment Is far
packages (SRPs) anviranment or the rate requests through hald the SRPs for the creation of rating
' emvironment that the system, this is the the QA and programs and
contains environment that will Production management of the
RateManzger. do the rating. environment. SRPs..
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INSTALLATION OF ORACLE CLIENT

The additional step of running the Oracle Client is described here. This can be performed as Step 10 in
the SoftRater Node Installation.

Because many corporate environments have a separation between the system administrator and the
database administrator, the following process may require both administrators’ access and permissions.

Before proceeding, please have ready:
e The LOBs you want to use.

e Your subscriber ID

NOTE: If you do not have database permissions, you will not be able to perform the following database
procedures.

NOTE: If you are unsure how to perform a database restore, please consult with your database
administrator.

1. Run the Oracle Client. On the machine where you want to connect an Oracle database. For
example, if you want your QA and Production environments to run on an Oracle database, you
will need to run the Oracle client on each machine. New folders will be created. Locate file
Insbridge/SoftRater/DDL/Oracle. The DDLs will need to be moved to your Oracle database or you
will need to pass them over to your Oracle DBA. If you are unsure of a what actions you can take,
please consult with your database administrator.

2. On your Oracle database, run all DDLs.
3. On your Oracle database, you will need to run a DT table for each LOB.

4. After all DT tables have been created, please make note of:
e Schema
e Instance
e User name
e Password

This information will need to be passed along to the IBRU installer. This information is needed to
create a logical environment.
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RUNNING THE ORACLE CLIENT

For a 64-bit environment, please make sure you have the 64-bit Oracle Client.

[ oracle Client [_ (O] x|
(;(_:;v | - Downloads ~ Insbridge = 4.0.1-insbridge-IBRU - Oracle Clisnt - - [EJ ISearch @J
File Edit ‘iew Tools Help
Organize ¥ 155 Wiews l@l
Favorits Links Mame = |-| Date modified |v| Type |v| Size |v| Tags |-|
doc 8/31)2010 10:39,.. File Folder
[/ pocuments instal &131/2010 10:37...  File Falder
FE Pictures rEspOnse 81312010 10:37...  File Folder
I Music &31J2010 10:35...  File Folder
Mare s E;setup Flz4jz008 ::25 PM  Application 328 KE
o SELLD 1102712007 12:4,,, Configuration Se... 1KB
Falders w | welcome 3172009 4:08 PM HTML Daocument 4 KB
=l m Downloads ;I
= | Insbridge (i
4.0, 1-insbridge-doc
= 4.0.1-insbridge-IBRL
Databases
IEY_IES Users
Oracle BI Publisher
O _lient
Misc Downloads
o100
FE- Favoarites
[ Links
r[} Music
FE Pictures
m Saved Games
PB Searches
rﬁ Videos
Public
[+ 18 Computer LI

Figure 60 Locating the Oracle Client for 64-bit Installs

1. Inthe 4.0.1-insbridge-IBRU folder, locate the Oracle Client folder.

2. Select the setup application. The Oracle client installation will begin.
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~#fl Dracle Universal Installer: Select Installation Type

S 1

Select Installation Type
Oracle Client11.1.0.7.0

What type of installati

Figure 61 Running the Oracle Client

5. Select RUNTIME as the Installation Type.
6. Click NEXT.

7. For the Summary — Inside Oracle Providers for .NET, the Oracle Client, you must use a LOCAL
DRIVE, i.e. C:\app\oracle-insbridge.

8. Click NEXT.

9. You can leave the defaults and INSTALL.
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LOCATION OF DDL DIRECTORY

If a database table needs to be added in SoftRater for Oracle, the DDLs are located in the IBFA
Installation Directory under the SoftRater/DDL folder. l.e. [INSTALL_DIR]/Insbridge/SoftRater/DDL. This
information may be needed if you are attempting to add an LOB and receive missing table errors.
Creating tables in Oracle should be performed by a qualified DBA.

ORACLE DATABASE SETUP

Oracle database files are packaged in the install. The IBSR_TEMPLATE file is located in the
Databases—>Oracle-> SoftRater folder. The file name is usp_IBSSR_v03.12.0.oracle.

IMPORTANT: Itis strongly recommended that any database modification be performed by a qualified
database administrator (DBA). The database setup procedures and tasks require the skill
set of a database administrator. If you are not a database administrator, please stop.
Improper setup may result in unwelcome changes to the database. Please consult with a
qualified database administrator before proceeding.

These instructions are high level and require that the setup person be a DBA.

1. You will need to create the database. Oracle Insurance does not have specific requirements,
whatever requirements are deemed necessary by your company’s internal standards will work. It
is recommended that you included the version number or environment name if you are planning
on creating more than one instance.

Have this information ready:

e The LOBs that your company uses. You will need the ID number for each LOB.
e Your customer number.
o Location of the Insbridge files.

a) Create default tablespace for the Soft Rater database.

o If a database table needs to be added, the DDLs are located in the IBFA Installation
Directory under the SoftRater/DDL folder. |.e.
[INSTALL_DIR}/Insbridge/SoftRater/DDL. See Location of DDL Directory.

e You will have to replace the TABLESPACE name in the scripts with the tablespace
name you used when you created the database.

e Onthe DT tables, you will need to create one for every LOB. An example of the
format is in the comments of the script. It requires the LOB ID number and the
customer number.

b) Create user IBSR and assign basic connect and resource grants.
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Using a DB2 Database

A DB2 database may also be used. To obtain the DB2 client, please visit the IBM website and download
the Client for the version you have.

If a database table needs to be added in SoftRater for DB2, the DDLs are located in the IBFA Installation
Directory under the SoftRater/DDL folder. l.e. [INSTALL_DIR]/Insbridge/SoftRater/DDL. This information
may be needed if you are attempting to add an LOB and receive missing table errors. Creating tables in

DB2 should be performed by a qualified DBA.
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Chapter 6

SOFTRATER INSTALLATION — JAVA

A Windows/JAVA/Oracle Database Environment Example:

IBRU Installation/Setup — Windows/JAVA Incorporating an Oracle DB

This envirenment is for
the creation of rating
programs and
management of the
SRPs..

|B_CLIENT. The SQL

Server should be on

a separate machine.
These DBs will
connect to the
Development

amvirohment or the
environment that
containg

RateManager.

The Oracle DB will
hold the SRPs for
the QA and
Production
anvironment.

This environment
is for the testing of
packages (SRPs).

Development saL Tl QA Production
Windows Java Java
Rating and Rules . .
Authoring %a'_-"ﬁeg DB for SRPs Test Rating Production Rating
INSTALL: .
RUN: INSTALL: INSTALL:
IBFA
RM DDLs BSS IBSS
OBl Publisher
RUN: CREATE:
Oracle diant DT table for each CEsaE CEsaE
e ical Logical
Environments: Environments:
CREATE SR - to identify Froduction - to
SUBSCRIBER L Jeixi=
IBSR DB and identify the IBSR
location. DB and location.
ADD
DE Connections: \H/-n-\ \H/_n-\
Contraller RESTORE:
Security
RM IB_CLIENT
security
CREATE:
RESTORE:
Lagical
Envircnments: (=]
Rating/Rules
RM — to handle
testing/rating.
QA_SR - This CREATE:
emviranment
contains the full SR - the
packages to be IBSR DB for QA
loaded to the QA
DB.
Production SR — CREATE:
This environment
contains the full Production - the
packages to be IBSR DB_ far
loaded to the Production
Production DB.
\.._./_‘-\ PURFPOSE For
setting up this
Physical
PURPOSE Faor Environment PURPOSE For PURPOSE For PURPOSE For
setting up this setting up this setting up this setting up this
Physical S0L Server is Physical Physical Physical
Environment required for RM and Enviranment Enviranment Environment

This environment is
for (reaklime)
production rating.
When users send
rate requests through
the system, this is the
emvironment that will
do the rating.
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The Windows/Java environment utilizing an Oracle database example will displayed by machine and
contains 3 application servers and 2 database servers. There are still three environments; development,
QA and Production. The Oracle database server will contain two separate databases. Clear and precise
naming of the associated databases is recommended.

SoftRater can be run on a non-Windows machine if a compatible application server platform such as
WebLogic, WebSphere, or JBoss is running as well. If a non-Windows machine is used for SoftRater, you
will need to download a Java version of SoftRater from E-Delivery. The Java version of SoftRater will
need to be loaded onto the machine with the compatible application server platform.

The Oracle database can be setup after the subscriber has been created and the lines of business have
been selected. You will need this information to complete the Oracle database setup.

THE SETUP

1. The Development environment:

a.

oo

f.

g.

Contains one Windows application server and one separate SQL Server
database.

RateManager and IBFA/SR-WIN would be located on the same Windows
machine. RateManager and IBFA must run on a Windows Server machine.

OBI Publisher is installed for reports to be created.

The subscriber ID would be created here.

On the IBFA/SR-WIN for this environment, three database connections would be
created and three logical environments would be created.

The Oracle client would be run on the Windows machine.

Two databases would be restored to the SQL Server machine.

2. The QA environment:

a.

b.
c.

d.

Contains one JAVA application server with WebLogic, WebSphere or JBoss
installed and running. There is one separate Oracle database server that will be
shared between QA and Production.

IBSS/SR-JAVA would be loaded on the JAVA machine.

On the IBSS/SR-JAVA for this environment, one logical environment would be
created.

One QA database would be created on the Oracle machine.

3. The Production environment:

a.

b.
c.

d.

Contains one JAVA application server with WebLogic, WebSphere or JBoss
installed and running. There is one separate Oracle database server that will be
shared between QA and Production.

IBSS/SR-JAVA would be loaded on the JAVA machine.

On the IBSS/SR-JAVA for this environment, one logical environment would be
created.

One PRODUCTION database would be created on the Oracle machine.

4. The Oracle Server:

a.
b.

Requires that the Oracle DBA run the DDLs.

Requires that the Oracle DBA create a DT table for each line of business in each
of the two database created. The subscriber ID and line of business number will
be required
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This is a basic Windows/Java utilizing an Oracle database setup. It is possible to create more
than three environments or use fewer than three. There are many combinations of platforms,
databases and environments that can be used. Please contact your Insbridge representative for
more information on the configuration that you would like to have.

TO INSTALL INSBRIDGE SOFTRATER SERVER

e See Installing SoftRater for WebSphere
o See Installing SoftRater for WebLogic
o See Installing SoftRater for JBoss

CONFIGURING INSBRIDGE SOFTRATER SERVER

Open an Internet Explorer web browser either remotely on the local IBRU web server and browse
to the following location, replacing SERVERNAME with the actual server name and PORT# with
the designated port:

http://SERVERNAME:PORT#/IBSS/

ORAC I_E‘ Insurance Insbridge SoftRater Server - Weblogic

SoftRater Administrator # Select an action to perform from the left pane.

® Resst Environments

® Submit InsBridge (el

& Submit Custom {xmil}

# Program Cache
®  Get Version

® st Config Path
® Gst Sample Files

®  Set WSDL (url)

o Get WSDL (url)

® Home

Figure 62 IBSS Home

NOTE: If you have renamed the databases, please make note of the new names.
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NOTE: Your subscriber should have been setup with your RateManager environment.

The Environment Setup section allows you to configure rating environments. An environment is a
pointer to a location where SoftRater Packages (SRP’s) are stored and loaded. There is no limit
to the number of environments you may have. To navigate to the Environment Setup page, select
the Environment Setup link available from the menu tree on the SoftRater page. Required fields
will be marked with an asterisk (*)

Browse to SoftRater Version 3>Environment Setup.

* Environment Setup

Status:

SELECT ENVIRONMENT | = Add Mew Environment << %

Envircnment Mame® |SUﬁ:Rater | Company Id*
Database Server® [10.200.10.200 | Port® queryBock| |
Database Name* |IESR | Schema nama** I:I

Catzbass User 1d* |sa |
Distabase Password® |IIIIIIIIIII |
Provider Typs M5 5QL Server ¥

Database Typs SoftRater hd

Data Dir |

* Fields are required.
** Fields required for an Orade DB connection.

Save Exit Test Connection! Delete!

Figure 63 Create a Rating Environment

To Create/Edit an Environment

1. To create a new environment, use the drop down text box next to SELECT
ENVIRONMENT and select >> Add New Environment <<. If you are editing an existing
environment, select the name from the drop down text box. If the page does not
automatically refresh, click |al |,

2. When the page refreshes, enter the following information:

Select Environment;

There are three types of Logical Environments:
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e Development
e Quality Assurance
e Production

After you have entered your logical environment, you must define it.
Database Name: The name of the database that packages are loaded to.

Database User Id: Username to access the database. This information may be
obtained form the Oracle DBA.

Database Password: Password to access the database. This information may
be obtained form the Oracle DBA.

Provider Type: The provider of the database. Options are DB2, DB2(AS400),
ORACLE and MS SQL SERVER.

Database Type: The type of database being accessed. Options are SoftRater
and RateManager.

Data Dir: The location of the SoftRater Packages (SRP’s).
Company Id: Your Company’s subscriber ID.

Port: Listening port to the target Database Management System.

Query Block: (Optional) For certain Database Management Systems (DBMS),
system batch query optimization is required for performance and/or because of
limits on/in the system. This value will control the maximum number of batch
query operations that can be submitted to the target DBMS in any one
transaction. It is known that for certain DB2 platform versions a value of 31 is
required because of a hard software limit.

Schema Name: The name of the schema that defines the structure of the
database. This information may be obtained from the Oracle DBA.

3. When you are finished entering information, click Save. The environment will be saved
and the Status field will update.

4. Before you can use the new or edited environment for rating, you will need to reload the
configuration XML file. This is done by resetting the environments.

For more information on working with IBSS, please see the IBSS User Guide.
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Chapter 7

UPDATING AN INSBRIDGE APPLICATION

If you attempting to update from a 32-bit Insbridge instance to a 64-bit Insbridge instance, please
contact Oracle Support.

UPDATING DATABASES

Database updates can be performed in RateManager for the IBRM and IB_Client databases. This
is the recommended way to update these databases. The SoftRater database will need to be
updated manually on the machine where it is located.

To update the RM and IB_Client databases, log into RateManager.

NOTE: If you need to go from an older version, such as 3.9, you will have to enter RateManager
and run the IBRM and IB_CLIENT update scripts in sequential order from there. You
must be a DB Owner to run the update scripts in RateManager.

NOTE: SoftRater update scripts must be run manually. See Manual Updates to the IBRU
Databases for more information.

UPDATING AN ORACLE DATABASE

On the Windows machine that hosts the Oracle database connection, run the Oracle Client.exe.

Select your company name underneath Config on the left hand side to enter the configuration
information for the environment you want to update.

DRAC I_E. Insurance Insbridge Framework Administrator

X
Config
I-[3 Insbridge
=-£3 SoftRater
.__.I Engine
E||_..I Explorer Explorer Add Environment
Insurance Company Add, edit, or remove environments from your Explorer configuration,
- SoftData - DESCRIPTION
-l Services
il @ BM - Development
-4 Logs )
953 Security P BEM QA - Quality Assurance
g ecuri

Figure 64 Obtaining Environment Information
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EEx

{= Framework Administrator, - Windows Internet Explorer

e

@.\-j‘ v [ hetpiocalrost/oF ajdefaut, aspx
Fle Edt Yew Favortes Tools telp

w & [@Framewnrkndmlmstramr ] 1

= »
g - |:2FPage ~ () Tools ~

D R’AC I_G’ Insurance Insbridge Framework Administrator

Version 3.1.1 (x86)

x|

=0 Insbridge |__rackeges || s |
£ SoftRater
i i Engne 3
! =3 Explorer Explorer DEVELOPMENT
H B Insurance Company Environment(s) you may use for development purposes, Selecting an environment below will denote it as the default.
[ SoftData
(3 Services Envircrment: M ®
3 Logs Test Environment. ..
(3 security DB Server: LocalHost
&5 SoftLibraries 08 ServerType:
~ @ Hee DB Catalog: IBRM
DB CatalogType:
DB Query Buffer:
DB Tablespace:
DB Schema:
DB User: D
DB Password: vensenee
Engine Location: LOCALHOST
Engine EnvDef: Discover
Environment(s) you may use for quality assurance purposes. Selecting an environment below will denote it as the default.
Environment: RM_QA @]
Package Location:  Ct\Program Files\Oracle|QA_SRP Test Environment. ..
DB Server: LocalHost
DB ServerType:
DB Catalog: IBSR
DB CatalogType:
DB Query Buffer:
DB Tablespace: v
< > Copyright @ 2000,2002, Orade and/or its affilates. Al rights reserved.
Done “J Local intranet H00% -

Figure 65 Editing Environment

Only the information required for this connection is: Environment, DB Server, DB Server Type,
DB Catalog, DB Catalog Type, DB Schema, DB User, DB Password, Engine Type and Engine
Location. The Package Location, DB Query Buffer, DB Tablespace and Engine EnvDef can

remain blank or filled out as needed.

For each environment, you can set up the following information:

Previous Value

Updated Value

Environment: The name of the environment.
Selecting the radio button next to an
environment's name will set it up as the default
environment.

No change.

Package Location: Physical location of where
the packages should be stored. Click Test
Environment to run a process to validate the
permissions on the directory and certify any
packages in the directory. In order for the
Framework Administrator to successfully
manipulate packages in the location, it must
have full control of the directory.

No Change.
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DB Server: The name of the server that houses
the database that packages will be loaded to.

DB Server: The name of the server that
houses the database that packages will be
loaded to. For DB2 servers, this is the DB2
Registered Alias Name. For Oracle servers,
this is the server name; either IP or DNS will
work. The Database listener port number
will also need to be appended to the server
name if it is something other than the
default port.

The format for this is as follows: [SERVER
NAME]:[PORT NUMBER]

DB Server Type: The type of server that
houses the database. Currently, RateManager
and SoftRater support SQL Server, Oracle and
DB2.

No Change.

DB Catalog: The name of the catalog in the
database. Not required for SQL Server.

DB Catalog: The name of the catalog in the
database. For DB2 servers, this is the
System DSN Name. For Oracle servers, this
is the instance.

DB Catalog Type: The type of catalog in the
database. The types available are:
RateManager, SoftRater and Other. If you are
using a SQL Server, you can choose either
RateManager or SoftRater.

DB Catalog Type: The type of catalog in
the database. The types available are:
RateManager, SoftRater and Other. If you
are using a SQL Server, you can choose
either RateManager or SoftRater. If you are
using an Oracle or DB2 database, you will
need to choose Other and enter the
remaining information.

Previous Value

Updated Value

*DB Query Buffer: For certain Database
Management Systems (DBMS), system batch
query optimization is required for performance
and/or because of limits on/in the system. This
value will control the maximum number of batch
query operations that can be submitted to the
target DBMS in any one transaction. It is known
that for certain DB2 platform versions a value of
31 is required because of a hard software limit.

No Change.

*DB Tablespace: The name of the table space
in the database.

No longer required.

*DB Schema: The name of the schema that
defines the structure of the database.

*DB Schema: The name of the schema that
defines the structure of the database. This
information may be obtained from the
Oracle DBA.

DB User: Username to access the database.

DB User: Username to access the
database. This information may be obtained
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from the Oracle DBA.

DB Password: Password to access the DB Password: Password to access the
database. database. This information may be obtained
from the Oracle DBA.

Engine Type: The type of SoftRater engine that | No Change.
is used. The available options are: SoftRater for
Windows, SoftRater for WebSphere, SoftRater
for WebLogic, or SoftRater for JBoss.

Engine Location: The location of the SoftRater | No Change.
engine. If the engine is local to the Framework
Administrator (i.e. located on the same server),
leave this field as LOCALHOST. If the engine is
located on a different server, enter the name in
the box.

Engine EnvDef: This field should remain blank, | No Change.
unless the engine is located on a different
server. If the Engine Location is set to
LOCALHOST, leave this field blank. If the
Engine Location is not LOCALHOST, this
should match the name of the environment on
the remote server.

NOTE: If you are using an Oracle or DB2 server, the options and requirement will be different.
Please see the Insbridge IBFA User Manual (Located in the User Guides directory) for
more information.
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Chapter 8
WORKING WITH RATEMANAGER FOR THE FIRST TIME

The URL for RateManager will be http://INSTALLATIONSERVERNAME/RM. Where Installation
server is the server where RateManager was installed.

This will place you on the RateManager login screen.
1. To login for the first time, select your company from the drop down menu.
2. The user name will be demo.
3. The password will be password.

To change your password, go to Administration>»Change Password.

For more on user management, please see the RateManager User Guide.

NOTE: If you log into RateManager and Tools is the only option, you must perform a database
update.

NOTE: If you are having difficulties logging into RateManager, please check the error logs in
IBFA.

RUNNING DATABASE UPDATES IN RATEMANAGER

If you log into RateManager and Tools is the only option, you must perform a database update.
After you perform the database updates, to view all menu options, click File>Reload.

/= Oracle Insurance Insbridge RateManager 4.00 - Windows Internet Explorer,

OIRACLE" Insurance Insbridge RateManager
File Tools Help

B Database » ¥ Backups
% Updates

Hom

Figure 66 Tool Mandatory Update

On the DB Updates screen, the current version will be highlighted and the status will be Current.
The updates below the current version will be grayed out. These updates cannot be run again.
You will receive an error message if you attempt to run a lower version update. Any version
update above the current version will also be grayed out but will be available for executing.
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Updates have to be installed sequentially, meaning if you are on Version 3.9, you must run the
3.10 update, then the 3.11 update, the 3.12 update, the 3.13 update and finally the 4.0.1 update.
If you attempt to run an update that is more than one level above the current version, you will
receive an error message.

1. Navigate to the Tools->Database->Updates.

2. Select the database you want to view from the Show updates for drop down. The
database updates will be listed. The last column, the Status column, will show you which
update is the Current one installed.

OIRACLE" Insurance Insbridge RateManager

File Modules Tools Help

ome (fj DB Updates x

(@ DB Updates
.L-E Execute Update Script JE Open Update Script E Save Update Script to File Elﬂ Refresh

| Show updates for:| IBRM W

Scnpt Release Date Database Status
vid4,00.1.00 &/15/2010 IBR.M
wiO<4.00.0.00 2/10/2010 IBR.M

v03.13.0.00 12/15/2009 IBR.M

03.12.0.0 4/30/2009 BF.
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Figure 67 Available Updates

3. There are two ways to execute an update:

a. Directly in RateManager: This is recommended way to update a database.

i. Highlight the update you want to run. Begin with the lowest update. For
example, if you are going from version 3.9, you must run the version 3.10
update first and so on. Click Execute Update Script. A warning
message will be displayed.

ii. Click OK to run the update or Cancel to return to the previous screen.

iii. Do this for both the IBRM database and the IB_CLIENT database.
iv. Close the DB Updates tab.

v. If the screen does not refresh, you can either log out and log back in or

click File>Reload. This will refresh the screen.

b. Use Query Analyzer: This method should be performed by a database
administrator. No warning message will be displayed if you execute scripts in the
wrong order. You must know the name of the databases you are updating.
Please see Manual Updates to the IBRU Database.

Oracle Insurance Insbridge Rating and Underwriting Installation and Upgrade Guide Page 100



UPDATING PREFERENCES

Administrators can edit web settings at any time from the Preferences option in RateManager.
Changes will take place after the user sessions have been ended. If web settings are changed
while the users are inside the module, the change will not be visible to them. Prior to users
accessing RateManager for the first time, it is recommended that Preferences be set.

To Change Settings

1. Select Tools=>Preferences.

Tools Help

Manage Lines

Audit
Import Pragrams

Security ]

Database 3

Change Passwiord

e @

Preferences

2. This will open the Preferences window. Select Web Settings.

3
Preferences
[=-Settings
2-User a
Web Settings
-Hame Page
E-Administratar
: i Insbridge Configiml Path:  [C:\PROGRAM FILES\ORACLE\IGEU\INSERIDGE|FRAMEWORK\]
-Web Settings
Messaging Server : |loca|hc\st | {Secure Channel) I:l
SoftRater Server : ||Dca|hgst | {Secure Channel) [
Backup Shars Folder | |
Location:
Use Inshridge Com+
i
Enforce Release Packaging:
Batch Package Thraads:
Minimum Login User ID
Length:
User must change
passwiord: (Day=)
Show Override Date Mask:
Allows Data Type Change:
Inactive Session Time Cut: E {hrs)
Estch Results with Mewline:
‘Online Help Server: |loca|hc\st |
My Recent List:
Default Proxy Scri
aubn: == |hﬂp:,-',-'v.'pad,-’v.‘pad.dat |
Change Control: 2
w?  Save | @ Cclose |

Figure 68 Preferences Settings
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3. Make any necessary changes. If you do not know all the settings, you can come back
and edit lat a later time. It is recommended that you update the ONLINE HELP Server
immediately.

4. When you are finished, click SAVE to update your settings.

Web Settings

Insbridge ConfigXml Path

This is the path from IBFA. This pathway must match the IBFA path. You may need to change
this path if you have changed the path in IBFA. Please contact Insbridge support for further
information. It is strongly recommended that you leave the default.

Messaging Server

RateManager is set up to run batches on the same server that RateManager is located on. If you
have an especially large batch to run and you want to batch to a different server, you will have to
change server locations here. Unless necessary, it is strongly recommended that you leave the
default.

SoftRater Server

If you need to rate on another server, you will have to change server locations here. It is strongly
recommended that you leave the default.

Backup Share Folder Location

When you make backups of the RateManager database, you can specify the location of the
backup file. If the location is local, you will use a local path. If the location is not local, you must
be a disk admin to change.

Use Insbridge Com + Admin

This setting must always be true. If there is a conflict, please contact Oracle Insurance support.

Enforce Release Packaging

When set to False, a release is not required in order for users to create a SoftRater (full)
package. False is the default setting.

If set to True, a release is required in order for a SoftRater (full) package to be created. If a user
wants to create a SoftRater (full) package in the Program Explorer module, a release must be
created in the Releases area first. This release must have the program added to it and be
unlocked. When the user creates the SoftRater package in Program Explorer, they will have the
option to select the Release they want this package to be placed into. If there is no release, or no
release that contains that program and is unlocked, then the user will be able to do RateManager
(local) packages only.
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Batch Package Threads

RateManager allows you to change how many threads are used. Threading enables a process to
finish faster by splitting the process into smaller processes that run quasi-simultaneously. On
multiprocessor systems, using multiple threads enables the operating system to assign the
threads to different processors.

In addition, the Framework Administrator also enables you to change the administrator email
address for each client. When a process fails, an email will be sent to the person who initiated the
process, as well as to the administrator email addresses listed for the client of that process.

NOTE: Before changing the number of threads, you should consult with your system
administrator. Setting the number too high can result in poor performance or even
a system crash. If you are unsure of how many threads to use, set the number to 1.
For single processor systems, Oracle Insurance recommends a maximum of 2
threads.

Minimum Login User ID Length

This is the minimum number of characters required for a user ID.

User must change password

This where you set the number of days before a user is required to change his/her password.
This setting will only be active when you elect to have users change their password on the user
setup screen.

Show Override Date Mask

If enabled, a date mask for ‘Date’ data types will be displayed when importing a table. If not
enabled, this field will not be visible.

Allow Data Type Change

The type of data associated with a parameter. RateManager supports three (decimal, integer and
string) data types for variables and inputs and a fourth (date) for inputs and result variables only.

Setting this option to True will allow RateManager users change the data type of a variable or
input. Setting this option to False will not allow users to change data types.

Inactive Session Time Out

This is the amount of time that a user sits inactive before being automatically logged out of the
system.

Batch Results with New Line

Allows batch results to go to a new line instead of forming one continuous string. A True setting
will place a carriage return between result files. A False setting will result in one continuous string
without a break.
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Online Help Server

Online help is installed with RateManager. This setting should be the server name where
RateManager currently resides. Either a server name or an IP address can be entered here. If
needed, you can change the name of the server. For example, if the machine name is not the
same as the host name, you may need to change the name in order for online help to function.

Change Control

If change control is on, it will be mandatory for users to enter a change control entry and
justification to any element or program when it is revisioned. If change control is off, the option will
not be presented.
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Chapter 9

MANUAL UPDATES TO THE IBRU DATABASES

In the RateManager, Security, and SoftRater Database folders you will find the current database
scripts. The RateManager and Security database update scripts will take previous IBRM and
IB_CLIENT databases from version 3.13 to version 4.0.1 only. To go from a lower version up
to 4.0.1, you must enter RateManager.

The IBSR database update will need to be run once, regardless of version, in the corresponding
database. If you are updating from a release previous to 3.13, please see UPGRADE NOTICE on
page 109.

NOTE: Oracle database updates must be performed directly on the Oracle database by an
Oracle DBA. Improper scripts updates can result in database failures. Oracle database
updates are not available on RateManager.

TO PERFORM DATABASE UPDATES FROM RATEMANAGER

The preferred method of updating the IBRM and IB_CLIENT databases is to go into
RateManager. If the administrator has DB User privileges and is the DB Owner of the database
as well as the disk administrator, database updates can be done on the
Tools>Database>Updates tab. If these privileges are not in place, an error message will be
displayed. See Running Database Updates in RateManager for instructions.

NOTE: If you need to go from an older version, such as 3.9, it is strongly recommended that you
enter RateManager and run the 3.10, 3.11, 3.12, 3.13, 4.0 and 4.0.1 update scripts
successively from there.

To manually update a SQL Server database, you will be required to save off each update and run
them in sequential order in SQL Server. A DBA or a person with the proper permissions will need
to apply the database updates using Query Analyzer.

1. In RateManager, highlight the update you want to run. If you are going from a much lower
version of RateManager, you may have to save multiple files for each database.

2. Click Save Update Script to File. Your computers dialogue box will be displayed. Save
the file to a location of your choice. For IBRM scripts, it is recommended that you rename
the file to usp_IBRM_RO(version number).sql. For example the V3.10 update would be:
usp_IBRM_R0310.00.sql. For IB_CLIENT scripts, it is recommended that you rename the
file to usp_IB_CLIENT_RO(version number).sqgl. For example the V3.10 update would be:
usp_IB_CLIENT_R0310.00.sql.

3. To view the update script prior to execution, highlight the update you want to view. Click
Open Update Script. The update script will be displayed in a separate screen.
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2 IBRU : v04.00.0.00 -- Webpage Dialog

qadose

PRINT ' e e R e e e e AR R AEELLECEEECACRCRRRRRLALLECEERRRRACRRRRRRRE
Eletcclelelelel e et el el el e e el e e el el el el el et el elel el et e el el el el el el e e el el el el el el el ettt el el el el et el e ettt el el e e
BEEEEEERERAAEEEECEEARRRRRERRRRRRR

FRINT ' THE WARNINGS BELOW ARE EXPECTED WARNINGS..... '

PRINT ' Cannot add rows to sysdepends for the current stored procedure becaunse it
depends on the missing object usp I RM SAVE COMPANY PATHS. The stored procedure

will =till be created.’

PRINT ' Cannot add rows to sysdepends for the current stored procedure becaunse it
depends on the missing object usp U RM UPDRTE CATEGORY PATHS. The stored procedure
will =till be created.’

PRINT ' Cannot add rows to sysdepends for the current stored procedure because it
depends on the missing object usp IDNX getCategoryProgramInputsSystemXML. The

stored procedure will still be created.'

PRINT ' Cannot add rows to sysdepends for the current stored procedure because it
depends on the missing object usp RM ITEM CHECEOUT. The =stored procedure will

ztill be created.’

PRINT ' Caution: Changing any part of an object name could break scripts and stored
procedures. The COLUMN was renamed to IMPORTED WVERSION.'

PRINT 'GEEEEEE R R e e e R AR R A EEEEEACRRECRRRRREAREEEEERRREARRARRRRRRER
B R A e AR R e R R A R A e AR EEARRREAEEEERRRRAREEERERRRRE
BEEEEEEEEEEEREERARRRARARLRRERRRRR

fewwas® Object; Table [dbo].[USER_PREFERENCES] Script Date: 07/09/2009 11:15:25
wEEER R

SET ANSI NULLS ©CN

GO

SET QUOTED IDENTIFIER ON

GO

IF MOT EXISTS (SELECT * FROM dbo.sysobjects WHERE id = OBJECT_ID(N® [dbo].
[USER_PREFERENCES] ') AND COBJECTPROPERTY (id, N'IsUserTable') = 1)

BEGIN

CREATE TABLE [dbo].[USER PREFERENCES] |

[USERID] [nchar] (100) NOT WULL,

[ITEMID] [int] IDENTITY(1,1) NOT NULL,

[NAME] [nvarchar] (256) NOT NULL,

[VALUE] [ntext] NULL,

[TYPE] [nchar] (100) NULL,

[DATETIMESTAMP] [datetime] NOT NULL CONSTRAINT
[DF USER PREFERENCES DateTimeStamp] DEFAULT (getdate()),

St o - —
Figure 69 Script Viewer

4. If this is the script you want to run, open Query Analyzer in SQL Server.

NOTE: If you do not have database permissions, you will not be able to perform the following
database queries.

NOTE: When using Database Engine Query, the SQL scripts must run on each individual
database.

5. Open up the DB script updates from the download file. You can open in any program
you want, such as Notepad. Begin with the next sequential update. For example, if you
are going from V3.9 to 4.0.1, open 3.10 first.
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Figure 70 Updating Database

10.

11.

12.

13.

14.

15.

16.

17.

18.

Select the database you want. In SQL Server Management Studio, create a new
Database Engine Query, File>New->Database Engine Query.

The query screen will be displayed on the right hand side.

Copy the first update from Notepad and paste onto the query screen.

Click Execute. The script will execute. Any messages will be displayed in the lower
portion of the screen. You must run the updates in sequential order. Run each update
until you run the 4.0.1 update. Then continue on to the next database.

For example, if you want to update the IBRM database in SQL Server, select the IBRM_
database. In SQL Server Management Studio, create a new Database Engine Query,
File>New—->Database Engine Query.

The query screen will be displayed on the right hand side.

Copy the first update from Notepad and paste onto the query screen.

Click Execute. The script will execute. Any messages will be displayed in the lower
portion of the screen. Run each update until you run the 4.0.1 update. Then continue on
to the next database.

For example, if you want to update the IB_CLIENT database in SQL Server, select the
IB_CLIENT database. In SQL Server Management Studio, create a new Database
Engine Query, File>New->Database Engine Query.

The query screen will be displayed on the right hand side.

Copy the first update from Notepad and paste onto the query screen.

Click Execute. The script will execute. Any messages will be displayed in the lower
portion of the screen. Run each update until you run the 4.0.1 update. Then continue on

to the next database.

After the scripts have been run, return to RateManager. Click Refresh Listing. The
status should show current and the full RateManager menu should be displayed

The updates are now properly applied and users can log back in to the system.
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UPDATING THE SOFTRATER DATABASE FROM A LOWER
VERSION

For SQL Server Only: The only upgrade needed to perform for SoftRater is adding the new
stored procedures on all of the IBSR databases. This can be accomplished by opening Query
Analyzer and connecting to the IBSR database. Then run the included SQL script
usp_IBSR_v03.13.00.sql available in the install download.

For an Oracle Database: Run the corresponding Oracle file.
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NOTICE

UPGRADE NOTICE

This notice is for customers currently running a SoftRater for Java engine Release 3.12 or lower.
This includes:

o SoftRater for WebLogic

o SoftRater for WebSphere

o SoftRater for JBoss
Necessary updates have been made to the SoftRater for Java engines. This includes:

o SoftRater for WebSphere has been updated to SOAP version 1.1.

o SoftRater for WebLogic has been updated to SOAP version 1.2.

o SoftRater for JBoss has been updated to SOAP version 1.2.
These changes mean that the WSDLs for the SoftRater for Java engines have been modified.
Updated WSDL documents will need to be incorporated into any client calling application that
communicates with SoftRater. If upgrades are done to the SoftRater for Java engines without
updating the calling applications, the calling application will fail.
Please update a test environment prior to deploying to production. Install the .EAR file in a

test environment to obtain the WSDL. Update your calling application and then test. When testing
is complete, you can upgrade your other environments.

NOTE: Customers running a Windows only environment, without a Java component, will not be
affected.

These updates are for the 3.13.5 and 4.0.1 release of SoftRater for Java engines only.
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Support

CONTACTING SUPPORT

If you need assistance with an Oracle Insurance Insbridge Rating and Underwriting System
product, please log a Service Request using My Oracle Support at https://support.oracle.com/.

Address any additional inquiries to:

Oracle Corporation
World Headquarters
500 Oracle Parkway
BeSCN,X\OOd Shores, CA 94065

Worldwide Inquiries:
Phone: +1.650.506.7000
Fax: +1.650.506.7200
oracle.com

TTY ACCESS TO ORACLE SUPPORT SERVICES

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the
United States of America 24 hours a day, seven days a week. For TTY support, call
800.446.2398.
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